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Chapter 1 - Impulse Overview

The Impulse is the latest microstepping drive from Industrial Devices Corporation and this 
innovative drive will move your applications with a combination of features previously unheard of 
in the motion control industry.

The Impulse is a self-contained microstepping drive designed to operate permanent-magnet linear 
and rotary hybrid step-motors. Its internal control hardware is based on a digital signal processor 
(DSP) operating a pair of IGBT power amplifiers. The Impulse is fully protected against short-
circuits and overheating.

Responding to users who demand the ultimate in value and reliability, the Impulse employs the 
following features and performance enhancements:

This manual will enable you to 1) quickly setup and verify that your Impulse is operational, 2) 
configure and program the Impulse for your specific application, and 3) successfully troubleshoot 
possible performance problems.

Feature Function

Open Loop Stall DetectTM Allows a motor to run without an encoder and still be able to detect a stall

Dynamic SmoothingTM Move profiles are smoothed to minimize jerk

Multi-SteppingTM For full-stepping with the smoothness of microstepping

Motion Node 7 simple moves can be stored in the Impulse and activated via inputs or 
serial port. This feature is optional.

Xtreme SmoothingTM 6 component “gain” settings for low-speed smoothness, reduced vibration, 
and more usable torque

IDeal Performance Probe Automatic fine-tuning of the Impulse for optimum performance with the con-
figured motor

I/O Capabilities 4 configurable inputs and one configurable output provide the user with 
flexibility

Configurable I/O Polarity I/O polarity can be set to Active High or Active Low ensuring compatibility 
with a wide range of controls

Diagnostic LED Green for power ON/ENABLED, flashing green for DISABLED, red for ON/
UNCONFIGURED, flashing red for FAULTS

Ultra-Compact Packaging Top-notch performance, while consuming a minimal amount of space

Resolution Up to 100,000 steps/rev

FLASH Firmware Downloadable software facilitates quick upgrades over the internet

Current Reduction Modes Enable Stop (current reduced to 75% of drive setting if no motion occurs 
during a user-programmed amount of time)
Enable Idle (user-defined current reduction percentage if no motion occurs 
during a user-programmed amount of time)

Anti-Resonance Provides optimum torque and nulls mid-range instability

Integrated Cooling Tunnel For maximum performance and multiple drive mounting capability

Regenerative Circuit Dumps excessive power during deceleration
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Chapter 2 - Shipping Contents
Your Impulse will arrive equipped as listed in section #1. If any parts or accessories are missing, please call  
IDC Customer Support at: (800) 747-0064. Sections 2 and 3 are provided as reference material.

1 - What You Will Receive if You Ordered the Following:

2 - Ordering and Identifying an Impulse

3 - Accessories Currently Available for the Impulse

Impulse + FP100
(or FP220) Keypad Impulse Only Impulse + FP100-RS485

(or FP220-RS485) Keypad
1. Impulse Microstepping Drive 1. Impulse Microstepping Drive 1. Impulse Microstepping Drive
2. AC power cord for Impulse 2. Motor Connector 2. AC power cord for Impulse
3. Motor Connector 3. AC power cord for Impulse 3. Motor Connector
4. FP100 (or FP220) Keypad 4. IDCMotion Software 4. FP100 (or FP220) -RS485 Keypad
5. Remote cable for Keypad 5. Impulse Quick Setup/Ref. Guide 5. Keypad Power Supply
6. Keypad mounting gasket 6. Impulse User’s Manual 6. Remote cable for Keypad
7. Keypad mounting template 7. Keypad mounting gasket
8. IDCMotion Software 8. Keypad mounting template
9. Impulse Quick Setup/Ref. Guide 9. IDCMotion Software

10. Impulse User’s Manual 10. Impulse Quick Setup/Ref. Guide
11. Impulse User’s Manual

IMPULSE Input Power Capability Drive Type Communication Accessories

IM L T4

Using the tables below, fill in the boxes and you will be able to order or identify your Impulse:

Input Power Drive Type Accessories (order separately)
L  Line Voltage 120 VAC T4  Stepper Drive, 4 A  *FP_ _ _-_ _  Keypad Configuration

 DB25BO  25 pin D-Shell Breakout Board 
Capability Communication  SS-IO  25 pin I/O Cable - 2 ft.

M  Motion Node Version 2  RS232  SS-IO-6  25 pin I/O Cable - 6 ft.
D  Drive Version 4  RS485  SS-RS232  Serial Comm. Cable

 PCS-5004  Keypad to PC Cable

 PCS-5110  Screw-Mounting Bracket

 PCS-5111  DIN Rail Mounting Bracket

*FP100, FP220, FP100-RS485, or FP220-RS485

DB25BO
Screw Terminal
Breakout Board

SS-IO (2ft. cable)
SS-IO-6 (6ft. cable)SS-RS232

Impulse to
PC Cable

PCS-5004
Keypad to PC 
Cable

PCS-5110
Screw-Mount 
Bracket

PCS-5111
DIN Rail 
Mounting 
Bracket
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Chapter 3 - Connecting and Installing Your Impulse

The purpose of this chapter is to provide information that will help you connect and install your 
Impulse drive in its intended application.

The Impulse drive easily interfaces with a PC, PLC, Step & Direction Motion Controller, or IDC 
keypad. Block diagrams of several Impulse-based applications are shown below.

Typical Impulse Applications

PC
or 

Keypad

Indexer

Impulse

961/962

RS232C

RS485

Digital Inputs (4)
 Digital Output (1)

Fault Output
Step/Dir/Shutdown

or

Single or
Multi-Axis

PC
or 

PLC

I/O   TX  RX

Unit #1 Unit #99

RS232C

1 - 7 Stored Moves

PC
or 

PLC

RS485

Unit #1 Unit #32

I/O
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Read This Page Before Your Begin!

CAUTION!

• Always use caution when working with mechanical systems. Gears and screw-
driven cylinders are capable of exerting tremendous force against an obstruc-
tion.

• Always ensure that power to your system is OFF before performing any 
maintenance activity, or making any connections or adjustments.

• Do not insert objects into the Impulse drive. High voltages could cause per-
sonal injury, and equipment could be damaged beyond repair.

• Do not open the Impulse drive. The factory warranty will be voided if the drive 

is opened.
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A. Connecting a Motor to the Impulse

Connecting an IDC Motor
The A+, A-, B+, and B- phase outputs power the motor windings.

Connect motor wires to the motor connector (supplied) and plug the wired connector into the drive.
Drawings below provide color codes for IDC motors.

GND is internally connected to the earth pin on the power connector. This provides a convenient
terminal for grounding the motor frame and a motor cable shield. Note: If the motor is mounted on
a machine that is grounded, do not connect the motor to GND.

The two INTLK pins must be jumpered together on the motor connector to allow power to the
motor.

CAUTION! Do not remove the motor connector from the Impulse drive while power is
applied. Removing the connector while power is applied could damage the connector pins.

Do not extend the interlock jumper wire to provide protection for another connector interface. The
interlock circuit is susceptible to trips caused by noise-pickup in cables (20 kHz switching).

Note: This is a high-impedance safety-interlock circuit. If the interlock wire breaks, or the connector
is removed, the current to the motor is immediately stopped, the drive faults (latches) and the LED
on the front panel of the Impulse will flash five times (see LED Diagnostics on p. 3-8). 

Connecting a Non-IDC Motor
One of the Impulse drive’s more advanced features, Open Loop Stall DetectTM, is guaranteed only 
when matched with one of IDC’s S or P-series motors.

IDC’s S and P series motors have custom windings to provide optimum dynamic performance with 
the Impulse.  If you use another manufacturer’s motor, refer to Non-IDC Motors in Chapter 6, 
Hardware Reference, for more information.

IDC Motor Wiring/Color Codes

Quick Disconnect Cable Wire Color

A+ Red
A- Red/Yellow

*GND Green
B+ Red/White
B- Red/Black

*Gray-colored Quick Disc. cables are 
shielded - connect shield to GND.

P31/32/33S12/21/23/32/33 P21/22, S21/23

YELLOW

WHT/RED
RED

WHT/YEL

SHIELD

BLACK

WHT/ORG
ORANGE

WHT/BLK

YELLOW

WHT/RED
RED

WHT/YEL

BLACK

WHT/ORG
ORANGE

WHT/BLK

GREEN/YEL

YELLOW

WHT/YEL

WHT/RED
RED

SHIELD

BLACK

WHT/BLK

WHT/ORG
ORANGE

Series Parallel Parallel

Motor
Connector
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B. Serial Communication Connections

Making RS-232/RS-485 Connections
The standard Impulse drive uses a 3-wire implementation of RS-232C. The RX, TX, and COM lines 
are the serial signals supported. No hardware handshaking is required. Note that some RS-232C 
devices require handshaking, such as RTS and CTS. It is the responsibility of the user to disable this 
handshaking via software or hardware (see Troubleshooting RS-232C Communication Problems on 
page 3-6 for more information). 

If you will be using RS-485 communication, the typical 5-wire interface connection to a “host” is 
shown below. See “Multi-Dropping Impulse Drives with RS-485” on the next page for information 
on using termination resistors. Note: the maximum cable length for RS-485 communication is 4,000 
feet.

Make your RS-232C connection as shown below. The PC Cable (IDC P/N SS-RS232) shown below, 
is an ideal choice for making trouble-free RS-232C connections to the Impulse.

Comm Port Settings
RS-232C/RS-485

Baud Rate 19200 (fixed)
Stop Bits 1
Data Bits 8
Parity None
XON/XOFF Yes

IDC P/N
SS-RS232

RS-485

TX-
TX+
RX-

RX+
COM

COM PORT

 9-Pin 
Connector

3 (TX)
2 (RX)
5 (COM)

COM PORT

RS-232C

RS-485 Host
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Daisy-Chaining Impulse Drives
Your Impulse also supports daisy chaining. The unit address (range 1-99) can be set via the keypad 
or in Application Developer.

Rules for Daisy Chain Operation

1. Units on a daisy chain must be “device addressed’ (numbered) in order for communications to 
work properly. A unit’s address should increment upward as you move down the daisy chain 
from the PC (see illustration below).

2. Do not duplicate unit addresses.

3. Any loose RS-232C connections or miswiring along the daisy chain will cause communications 
to fail. Please double check wiring if communication problems arise.

4. Please call IDC if you need to daisy chain more than 99 drives. 

5. The hardware diagram below shows how to connect the daisy chain.

Multi-Dropping with RS-485
If you will be “multi-dropping” Impulse drives with RS485, add 120-ohm termination resistors 
across RX and TX connections of the last unit as shown below:

RX  TX  COM RX  TX  COM RX  TX  COM

RX
TX

COM . .

Impulse

Unit 1 Unit 2 Unit 3
PC/Host
RS-232C
Device

ImpulseImpulse

RS-485
Host

Add resistors as 
shown here:
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Troubleshooting RS-232C Communication Problems
If communications between computer and Impulse are unsuccessful, one or more of the following 
procedures will usually solve the problem:

1. Host transmit (TX) must be connected to receive (RX) of the drive unit, and receive (RX) of the 
host must be connected to transmit (TX) of the drive. If communication fails, try switching 
connections on either the host or the drive.

2. Some serial ports may require handshaking. 
Jumper RTS to CTS, and DSR to DTR (see table).

3. Check your ground connections. The COM 
terminal should be isolated from earth ground. Use 
DC common or signal ground as your reference - do not use earth ground or shield.

4. Voltage between TX and COM should be -8.0 to -12.0 VDC. Voltage between RX and COM 
should be 0 to -0.5 VDC. Consult factory if measured voltages are outside these ranges.

5. For RS-232C only: If any cable is more than 50 ft. long, you should use a line driver, optical 
coupler, or shield. Shields must be connected to earth ground at one end only.

6. Reminder for PDA Users: Programs such as Palm’s Hotsync Manager take over a comm. port. 
Be sure to close/exit these types of programs if you are using serial communication with your 
Impulse.

7. Important Application Note Regarding PC Com Port: PC FIFO (First In First Out) Buffers 
should be used and adjusted to the highest settings for fastest performance. This applies to both 
Receive and Transmit Buffers.

• In your Windows operating system, go to Start > Settings > Control Panel > System > 
Device Manager > Ports (Com 1, Com 2) > Port Settings > Advanced > Buffer.

• Select Use FIFO Buffers, and ensure both Buffers (Receive and Transmit) are adjusted to 
the High setting for best performance.

Jumpers 9 pin D 25 pin D
RTS to CTS 7 to 8 4 to 5
DSR to DTR 4 to 6 6 to 20
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C. Connecting an IDC Keypad
Two versions of IDC keypads can be used with the
Impulse drive. The FP100 works only with the
Impulse, while the FP220 can be used with the Impulse
as well as IDC’s Smart Drives (see keypad-specific
information below).

The COM PORT on the front panel of the Impulse is
used for connecting either version of keypad.

Power is applied to either version of keypad when
power is connected to the Impulse.

Using a Keypad with Impulse RS232C
FP100 Keypad
Connect the FP100 Keypad to the Impulse with the
cable supplied with the keypad.

FP220 Keypad (Version 3.0 or higher)
Only FP220 Keypad versions 3.0 and higher will work 
with the Impulse drive.

To use an FP220 keypad with your Impulse, you must 
set DIP-switch #3 to the ON position and switch #s 1, 
2, and 4 to OFF. 

The FP220 uses the same keypad cable as the FP100. 

Using a Keypad with Impulse RS485
Impulse RS485 requires either the FP100-RS485 or
FP220-RS485 keypad. 
 
On the FP220-RS485 keypad only, set DIP switches as
described above. Both FP100-RS485 and FP220-
RS485 keypad are connected as follows:

1. Connect the keypad cable to the keypad and to the
Impulse.

2. Connect the keypad power supply cable to the
keypad as shown in the illustration.

3. Plug in the AC adapter.

1

2

3

COM

PORT

I/O

COM
PORT

Keypad

Keypad

Keypad with Impulse RS232C

Keypad with Impulse RS485
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D. Connecting AC Power

There is no ON/OFF switch on the Impulse. AC power is
applied by plugging the *power cord (included) into the
connector on top of the Impulse.

Input voltage must be in the range of 120 VAC ± 10%, single
phase, 50/60 Hz, 500 VA max @ 4 Amps. Operation outside
these specifications will result in reduced performance, drive
faults, and may damage the drive.

When power is applied, the LED on front of the drive should
briefly turn red, then steady green. If a red light is present, see
Section E of this chapter for more information on fault detection
codes.

*Note: If the AC power cord requires replacement, the 
replacement must be rated for Hard Usage or Extra Hard 
Usage.

E. LED Diagnostic Indications

The Impulse drive detects and resolves fault conditions (see table below). Faults are signaled by 
either a steady red or a flashing red LED on the front panel. A solid green LED indicates normal 
operation. A slowly flashing green LED indicates a shutdown (disabled), while a rapidly flashing 
green LED signals a regen dump. Faults are cleared by either 1) cycling power, 2) sending a RESET 
command via the serial port or configurable logic input, or 3) probing the motor if the LED is steady 
red.

For more detailed explanation of faults refer to Chapter 7, Troubleshooting the Impulse.

To AC 
Power 
Supply

Diagnostic LED Indications
LED Signal Indication

Green (steady) Normal Operation
Slow Flashing Green Shutdown
Quick Flashing Green Regen Dump

Red (steady) Motor Not Probed
1 Flash Red Stalled

2 Flashes Red Undervoltage Fault
3 Flashes Red Overvoltage Fault
4 Flashes Red Overcurrent Fault
5 Flashes Red Interlock Fault
6 Flashes Red Overtemperature Fault 
7 Flashes Red EEPROM Checksum Fault

LED
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F. Connecting Inputs and Outputs

Connect your inputs and outputs to IDC’s 961/962 Indexer according to the information below.
Schematics for Impulse I/O circuits can be found in Chapter 6, Hardware Reference

Application Notes
1. On 961/2, ensure that Step/Direction and Differential Jumpers are installed (see 961/2 manual).

2. If using IDC P/N SS-I/O or SS-I/O-6 cable, cut one end of the cable if necessary (see table 
below for SS-I/O cable color-code). If making your own cable, or  using a non-IDC indexer, 
refer to the Impulse I/O Schematics (Chap. 6) and the 25-pin Connector drawing below.

3. Use a shielded cable, and connect the shield only at the Impulse. Connect shield to pin 9.

4. IDC offers a 25-pin screw-terminal breakout board (shown below) to add convenience and 
flexibility to your application. Terminals on the breakout board match the pins of the 25-pin 
connector on the Impulse.

5. When wiring TTL signals to other manufacturer’s indexers, the Step TTL command signals 
from the controller should be wired to Step +, the Direction signal to Dir +, and the Shutdown 
signal to SD + (Step -, Dir -, and SD - should not be connected). Remember, the drive common 
must be connected to the controller common.

6. Activating the Shutdown input disables the drive amplifier and de-energizes the motor. When 
this input is OFF the drive is enabled and the motor is energized. The polarity of this input is 
configurable.

7. The open-collector Fault Output turns ON (Active High) when any one of the LED-indicated 
conditions occur (see Section E, LED Diagnostic Indicators). The output stays ON while the 
LED flashes.

IDC Indexer
(962 Dual-Axis Shown)

Breakout
Board

P/N DB25BO

TO
 D

RI
VE

 1

SHLD
FLT-
FLT+
SD-
SD+
DIR-
DIR+
STEP-
STEP+
SHLD
COM
+5
Z-
Z+
B-
B+
A-
A+

1
2
3
4
5
6
7
8

COM
COM

1
2
3
4
5
6
7
8

O
UT

PU
TS

IN
PU

TS

IDC Cable P/N: SS-IO/SS-IO-6
Pin Impulse Signal Wire Color Pin Impulse Signal Wire Color Pin Impulse Signal Wire Color

1 STEP + Brown 10 COM Gray 19 COM Black/White
2 STEP - Red 11 COM White 20 Reserved Red/Black
3 DIR + Orange 12 Reserved Black 21 Reserved Orange/Black
4 DIR - Pink 13 Reserved Brown/White 22 COM Yellow/Black
5 SD + Yellow 14 INPUT 1 Red/White 23 Output 1 Green/Black
6 SD - Green 15 INPUT 2 Orange/White 24 Reserved Gray/Black
7 FAULT + Light Green 16 INPUT 3 Green/White 25 Reserved Pink/Black
8 FAULT - Blue 17 INPUT 4 Blue/White Note: Cable SHIELD is internally connected to the 

DB25 metal housing.9 Drain Violet 18 COM Violet/White
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G. Mounting the Impulse Drive

This section includes installation requirements, Impulse dimensions, installing and removing 
mounting brackets, and mounting the Impulse on a DIN rail.

Environmental and Installation Requirements

• Operating Ambient Temperature:   Max. 50º C (122º F) @ 4 Amps

• Storage Temperature:   Max. 65º C (149º F)

• Not intended for use in humidity above 95% (non-condensing), or at altitudes greater than 
3,048 meters [10,000 ft.]

• Heat Dissipation @ 4 A (typical):  32 Watts

• Leave 6 inches above and below drives for airflow and wiring.

• Leave 0.1 inch between drives for easier mounting.

• Air supplied to the Impulse must be uncontaminated.

Mounting Arrangements
The illustration on the right shows an example 
of an acceptable mounting arrangement.

COM

PORT

I/O

COM

PORT

I/O

COM

PORT

I/O

COM

PORT

I/O

COM

PORT

I/O

COM

PORT

I/O

COM

PORT

I/O

COM

PORT

I/O

COM

PORT

I/O

COM

PORT

I/O

6.0 in.
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Impulse Dimensions

5.599

6.365

6.000

1.779 1.779

5.599

1.779 6.365

TS 35 DIN RAIL

Impulse with Screw-type Mounting Bracket (P/N PCS-5110)

Impulse with DIN-rail Mounting Bracket (P/N PCS-5111

10-32 screw with
.305'' head ∅
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Inserting and Removing Mounting Brackets from the Impulse
Both Impulse mounting brackets are interchangeable and each is inserted or removed according to
the following procedures. No tools are required to insert a bracket, however a flat-bladed
screwdriver is required for removal. If additional brackets are required, see Chapter 2, Shipping
Contents, for part numbers.

Installation of Bracket (DIN Rail Bracket Shown)

1. Insert the bracket into the bracket housing from the
top side of the Impulse as shown in the drawing on
the right.

2. Slide bracket downward until a single click is felt
(detent position). The bracket will be seated in the
position shown at right. Note: If you push the bracket
beyond the detent position (second click), it will be
necessary to push the bracket back to the detent
position. 

Do not attempt to remove the bracket by pulling it
from the bottom of the bracket housing. Both bracket
and bracket housing could be permanently damaged.

Removal of Bracket (DIN Rail Bracket Shown)

1. Insert the tip of a flat-bladed screwdriver between
the bracket-release arms as shown in the drawing at
right.

2. Gently twist the tip of the screwdriver until the arms
are spread apart enough to clear the detent
mechanism on the housing. Maintain this position.

3. While holding the arms apart with the screwdriver,
push the bracket toward the top of the bracket
housing as shown in the drawing. 

Do not attempt to remove the bracket by pulling it
from the bottom of the bracket housing. Both bracket
and bracket housing could be permanently damaged.

Insert
Bracket

Slide Bracket into 
Position as 
Shown Here

Insert screwdriver 
blade perpendicular 
to bracket (profile of 
blade shown in 
spread position)

1

2

1

2

3 Push bracket free of 
arms and out the 
bracket housing

Twist until arms are 
spread apart - hold 
in position

Removal

Installation
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Impulse DIN-Rail Mounting
The DIN-rail mounting system is a combination of 1) a removable mounting bracket, which locks 
the drive onto the DIN-rail (installation on previous page), plus 2) the DIN-rail hanger on the upper 
rear part of the housing that suspends the weight of the drive on the rail.

Mounting the Impulse on the DIN-Rail

1. Hook the top of the DIN-rail hanger
over the top of the DIN-rail.

2. Rotate the Impulse drive downward
until it locks into place on the rail.

3. Pull back slightly on the drive to ensure
it is securely fastened to the rail.

Removal of Impulse from the DIN-Rail

1. Ensure power to the drive is OFF.

2. Remove the motor connector.

3. Insert tip of flat-bladed screwdriver into
slot provided on the bottom of the
mounting bracket (see drawings on the
right).

4. Gently pry downward until the bracket
disconnects from the rail. Note: The
bracket will fall approximately 1 inch,
but will still be retained by the Impulse
housing. Do not attempt to remove the
bracket by pulling it from the housing.

5. The bracket can be reset to the detent
position by pushing upward until a click
is felt (see “Installation of Bracket” on
the previous page).

1

2

Impulse Securely Mounted on DIN-Rail

Insert screwdriver blade 
and pull downward

Mounting

Removal

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 3 - Connecting and Installing Your Impulse

3-14

This page intentionally left blank

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 4 - Configuring Impulse with Application Developer

4-1

Chapter 4 - Configuring Impulse with Application Developer™

This chapter covers the installation and use of IDC’s Application Developer software to configure 
your Impulse drive.

Installing Application Developer on Windows 95/98/2000/ME/NT

1. Place the IDC CD in your CD-ROM drive and click on the Start button.

2. Click on Run.

3. Type the following in the Command Line box that appears (replace “x” with your CD drive 
letter if different):        x:\App_Dev\Setupex.exe

4. Click OK and follow the onscreen instructions.

5. Restart Windows (recommended).

There are no known installation problems with Application Developer, but please call the IDC 
Applications Department at (800) 747-0064 or (707) 789-1000 (from outside U.S.) if you need 
assistance installing this software.
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Using Application Developer

Application Developer’s graphic user interface allows you to configure and program your Impulse 
using an appropriately equipped computer. Upon starting Application Developer you will be given 
four options for beginning the configuration of your application (see window below). 

Select from one of the following options to begin configuring your Impulse:

1. Upload Project. If your drive has already been configured, this option allows you to upload a 
project file from the drive for editing (modification), troubleshooting, etc. See Upload Project 
on the next page for more information on using this option. The Project Wizard is the best 
method for initial drive configuration and building a new project file. 

2. Launch Now - Allows you to go directly to the main menu or tool bar buttons to quickly 
configure or change project parameters. See Launch Now on page 4-4 for more information.

3. Project Wizard - Clicking on the Project Wizard button will take you through the 
quickest, most accurate method of configuring the initial setup parameters for your 
project file (see page 4-5 for details).

4. Open an Existing Project. To bypass the Project Wizard and select a stored file from the Open 
File window, click on the Open an Existing Project button (see page 4-4).

1 2 3 4page 4-5
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Upload Project
1. Begin by clicking the Upload Project button on the

Application Developer Startup window. You will see the
Control Type Selection menu (shown right).

2. Configuration begins by selecting your Impulse from the
list of Steppers. Click OK.

3. Select the Port you will use to connect the Impulse.

4. Select the Unit Number (from 1 - 99) of the Impulse being configured.

5. To test communication using the current setup, click on Test Connection. Click OK.

6. Skip the section on Using the Project Wizard and go to Fine Tuning Your Application.

Note: Echo and Mode are not available; they have no effect on the Impulse drive.

Comm Port Settings 
(for reference only)
RS-232C/RS-485

Baud Rate 19200 (fixed)
Stop Bits 1
Data Bits 8
Parity None
XON/XOFF Yes

OR
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Launch Now
This method of beginning Application Developer is typically used by more experienced users of IDC 
products. Select your Impulse version and press OK. You can now go directly to the Main Menu or 
tool bar buttons to configure the Impulse (see Fine-Tuning Your Application).

Open an Existing Project
If you want to open a project file which has been stored on disk (not in the Impulse), select Open an 
Existing Project. Select the desired file and click on the Open button. After opening an existing 
project file, it is still possible to use the Project Wizard at any time by simply clicking on the Wizard 
toolbar button. See Fine-Tuning Your Application if you do not wish to use the Project Wizard.
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Using the Project Wizard
1. Click the Project Wizard button on the Application Developer Startup window.

• Select the product you are configuring, Impulse in this case, and click on Next.

• The Wizard Navigator (left side of window) allows you to quickly locate your current posi-
tion in the setup process. The column of boxes represents the parameter being configured. 
A box’s color represents its configuration status, i.e. gray indicates a parameter not yet con-
figured, yellow indicates the parameter currently being configured, and black indicates 
completed configuration of the parameter.

2. Click on the Next button and the Motor setup window will appear. The configuration procedure 
in Motor Setup differs slightly depending upon whether you are using IDC or Custom (user-
defined) motor (see Appendix C to configure a custom motor). IDC-supplied motors have been 
precisely characterized in motor files which reside in an Application Developer directory. These 
files cannot be altered or deleted. User-defined (custom) motor files must be created by the user. 

If you want to change the operational characteristics of an IDC motor, you can do so by selecting 
an IDC motor from the scrollable list and saving it under a new file name in the Motor Editor 
(the original motor file remains unchanged under its original file name).

• From the pulldown menu, select the IDC motor you will be using, or click on Add Custom 
Motor and see Appendix C for information on configuring a custom motor file.

Wizard 
Navigator
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3. Click Next and the first of three possible Mechanics setup windows will appear.  The 
Mechanics window that appears depends on the selection made in the Select an IDC 
Mechanical System list. 

Mechanics window A (shown below) appears when a Motor Only is being configured. This 
window shows the IDC motor or user-defined file name in the Part # text input box, and the 
Motor Rotor Inertia (in kg-cm2) of the motor being configured. 

• Select Motor Only.

• Load Inertia - Enter Load Inertia in the text input box.

• Move Unit - Choose your move unit from the pulldown menu.

Mechanics window B (below) will appear if an IDC Mechanical System (other than Motor 
Only) is selected. This window allows you to select an IDC Mechanical System, the Part # of 
the system, and the Stroke Length, Travel, Gear Ratio, or Table Diameter of the system.

• Select the category of IDC Mechanical System you are using.

• Select the Part # of the system.

• Select the Stroke Length (cylinders), Travel (tables), Gear Ratio (gearmotors), or Table 
Diameter (rotary tables).

• Enter the Load Mass (cylinders and tables), or Load Inertia (gearmotors and rotary tables).

• Select the Move Unit for the system.

A

B
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Mechanics window C will appear if you select Non-IDC Mechanics from the “system” list.

• Enter your Total System Inertia (Load + Mechanics + Motor).

• Select your Move Unit (steps, revs, mm, or inches) from the pulldown menu.

• Enter your Distance Ratio (only if inches or mm are the selected Move Units). You cannot 
enter Distance Ratio if either steps or revs has been selected.

4. Click Next and the Resolution setup window will appear

• Select your Step Resolution from the pulldown menu, or enter a step resolution in incre-
ments of 200.

5. Click on Next and the I/O (Input/Output) setup window will appear. Using the pulldown menus, 
select configurations for up to four (4) Discrete Inputs and one (1) Discrete Output. The buttons 
to the right of the inputs and outputs are provided for toggling between Active High (A.H.) and 
Active Low (A.L.). 

C
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Discrete Inputs (see pulldown menu)

Discrete Outputs (see pulldown menu)

6. When all parameters have been configured, click Next and the Accept window will appear. This 
display allows you to review the settings made earlier, or gives you an opportunity to return 
(Back button) to any parameter you may want to change.

• When satisfied with the setup of your system, click on Accept. The Wizard Navigator 
should now indicate that all setup parameters have been configured. Use the scroll.bar/but-
tons to review the project file. 
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7. Your basic project file has now been configured but the four “Finish” steps must be completed 
in order to send the project file to the drive and probe the motor.

• Click on Config. Comm Port (#1) and select the Port to which you are connecting the 
Impulse. Next, select a Unit Number (from 1 - 99) for the Impulse being configured. To test 
communication using the current setup, click on Test Connection. Click OK.

• Click on Send All (#2) to send the project setup parameters to the drive.

• Click on Probe Motor (#3). Pressing this button tells the drive to execute an electronic 
probe of the motor to determine a host of proprietary, internal settings for use in the anti-
resonance/stall detect features. Any time the drive is connected to a different type of motor, 
or if a new motor file is selected, the motor must be re-probed. When the drive is probing 
the attached motor, a 1 kHz tone will be heard emanating from the motor. Depending on 
motor type, this tone may persist for up to 15 seconds. Motor probe is not required each 
time the Impulse is powered on. .

• Click on Set Tuning Values (#4) and enter the values from your IDC motor label.

• The project file has been sent to the drive and your application can now be fine-tuned using 
the Axis Setup menu (starting on the next page).
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Fine-Tuning Your Application

Your basic system setup parameters have been configured by the Project Wizard, and though the 
system is functional, your application will probably require further configuration and fine-tuning.

The remainder of this chapter provides information on configuring your Impulse with Application 
Developer’s setup and I/O menus. In addition to the parameters configured by the Project Wizard, 
these menus provide additional features for more control of your system and greater capacity for 
applications. Also covered in this chapter is the Motion Node or Stored Move option.

The Project Wizard remains available at any time by clicking on the Project Wizard button. The 
Toolbar Buttons provide access to the setup parameters and other features that will be covered in 
the remainder of this chapter.

Toolbar Buttons
The Application Developer toolbar buttons allow quick access to most of the menus available on the 
menu bar. The toolbar buttons shown below are available when configuring an Impulse drive. If a 
button or item on the menu bar is grayed-out, that function is not available to Impulse users.

Axis Setup
• The Axis Setup menus consists of five configurable sub-menus. Click on the Axis Setup but-

ton or go to File > Axis Setup on the main menu bar. 

• The first menu to appear will be the Motor menu tab (begins on the following page).

• Important! After making changes in the Axis Setup menu, remember to perform 
a Send All command (Send All button or Communications > Send All) to send 
newly configured parameters to the drive.

Reset
Impulse

Send
All

Receive
All

Edit
Stored Moves

View
Configuration

Project
Wizard

Axis
Setup

I/O
Setup

New
Project

Open
Project

Save
Project

Print
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Motor

• Motor Name - Select your motor from the list, or click on the Edit Motor button to create a 
custom motor file or edit an existing IDC motor file.

• Electrical - These text input boxes display the electrical characteristics of the selected motor. 
If a text input box displays a zero (0), that particular electrical characteristic has not been con-
figured as part of the motor file. To create or change a motor file, see Edit Motor.

• Mechanical - These text input boxes display the mechanical characteristics of the selected 
motor. If a text input box displays a zero (0), that particular mechanical characteristic has not 
been configured as part of the motor file. To create or change a motor file, see Edit Motor.

• Edit Motor - See Appendix C for information on using this feature. The “Advanced” tuning 
feature is also covered in Appendix C.

See Appendix C
to Edit a Motor
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Mechanics

Move Unit and Total Inertia (kg-cm2) are displayed on this tab, but they are not editable 
parameters. Click on the Change Mechanical System/Units button to edit your mechanical 
parameters.

• Change Mechanical System/Units - The text input-box parameters (in each available Setup 
Mechanical System window) are dependent upon the selection you make from the Select 
Mechanical System list. Examples of different mechanical parameters are shown below.

Windows for Configuring IDC Mechanical System Parameters

Parameters for
non-IDC Mechanics

Notes:

• Motor Rotor Inertia is provided for 
reference only. 

• Enter your Total System Inertia 
(Load + Mechanics + Motor).

• Ensure all units have been con-
verted to kg-cm2.
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Command

The Command Tab allows you to configure the Command Signal and Jog Input parameters, and 
to select the level of Numeric Precision that Application Developer will use to build the project file.

Command Signal Configuration 

• Drive Resolution - Enter the operating step resolution in integer multiples of four times the 
tooth count of the motor (50 tooth count x 4 = 200), or select a resolution from the scrolla-
ble list. Note: the default resolution is 25,000 and the valid range is 200 to 100,000.

• Stop Rate - Enter the deceleration rate of the motor when a STOP or EOT input is acti-
vated (see Limits Tables in Ch. 9, Troubleshooting the Impulse). Notes: (1) The Stop Rate 
units are user-defined (selected).  (2) The Stop Rate should be a value that ensures enough 
torque to control deceleration while not allowing the motor to stall.

• Direction - Sets motor direction. Toggle the Direction button to select Direction + (CW) or 
Direction - (CCW).

• Shutdown Polarity - Toggle the Shutdown Polarity button to select Shutdown Active 
Low or Shutdown Active High.

Jog Input Configuration

 This option allows you to modify the jog parameters (Jog Accel, Jog Low, Jog High) to be 
used by the Jog Inputs (JOG+, JOG-, JOG SPEED). These values will be in displayed in units 
selected in the Project Wizard (Mechanical Setup Move Units) or in Axis Setup > Mechanics 
> Change Mechanical Sytem/Units. 

Note: Numeric entries made in the Jog Input Configuration section of the Command tab 
are applied using the user-defined units shown. If the units are changed (Setup > Axis > 
Mechanical > Change Mechanical System/Units), the user must edit the Jog Input 
Configuration values to obtain the intended velocities and acceleration in terms of the new 
units. Application Developer does not automatically translate the numeric values when the 
units are changed.

Enter Jog values directly in the text input boxes or use default values (shown below).

• Jog Accel (Jog Accel/Decel) - Default = 20.00 (user-defined units)

• Jog Low (Jog Low Speed) - Default = 0.50 (user-defined units)
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• Jog High (Jog High Speed) - Default = 2.00 (user-defined units)

Numeric Precision

• Select Standard to limit the decimal precision of accelerations, decelerations, velocities, 
and distances to the following:

Accels and Decels: #.x (One decimal place)
Velocities: #.xx (Two decimal places)
Distances: #.xxx (Three decimal places)

The Standard decimal precision is sufficient for most applications. Standard is the default 
setting.

Note: The keypad (FP100 or FP220) only supports Standard decimal precision, therefore 
project files intended to be used in conjunction with the keypad must be created using the 
Standard setting.  Attempting to load a project file into the keypad without Standard 
decimal precision will result in an error.

• Select Extended to limit the decimal precision of accelerations, decelerations, velocities 
and distances to the following:

Accels and Decels: #.xxx (Three decimal places)
Velocities: #.xxxxx (Five decimal places)
Distances: #.xxxxx (Five decimal places)

Project files created with Extended decimal precision may be edited only in Application 
Developer.
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X-Smoothness (Xtreme Smoothing™)

The X-Smoothness tab is the most advanced low-speed tuning feature currently available on any 
microstepping drive. The benefits of low-speed smoothness are 1) reduced vibration, and 2) an 
increase in torque, which was typically lost to vibration before the arrival of the Impulse drive.

Achieving this revolutionary smoothness is easily and quickly accomplished by following the 
simple procedure below. Note: the motor must be disconnected from its load while performing 
Xtreme Smoothing™.

• X-Smoothness Sliders - Click and drag the indicator to change a value.

• Test Speed - This text input box displays the Recommended Test Speed and may be edited 
if necessary.

• Recommended Test Speed - This value has been either 1) pre-configured for IDC motors, 
or 2) calculated when a custom motor file was created in the Advanced Motor Editor. Verify 
that this value has been entered in the Test Speed display.

• Run Test/Stop Test Button - Toggles between Run Test and Stop Test.

• Restore - Restores each X-Smoothness to the previous values.

Adjusting X-Smoothness #1, #2, #3 
Important: Whether using an IDC motor or a non-IDC (custom) motor, all six X-Smoothness 
values (L1, L2, M1, M2, H1, H2) must be adjusted in the order described in the following 
procedure. Note: Slider bars L1 and L2 are interactive, as are M1 and M2, and these interactive 
sliders should be alternately adjusted until the deepest null setting is achieved.

X-Smoothness #1

Recommended values for L1 and L2 have been pre-configured for IDC motors, but we 
recommend that these settings be verified and adjusted if necessary by the following procedure. 
If you are using a custom motor file, these values were calculated in the Advanced Motor Editor.

1. Press the Run Test button.
2. Move slider L1 left and right until the smoothest running condition is reached.
3. Move slider L2 left and right until the smoothest running condition is reached.
4. Press Stop Test.
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X-Smoothness #2 

Recommended values for M1 and M2 have been pre-configured for IDC motors, but we 
recommend that these settings be verified and adjusted if necessary by the following procedure.

5. Press the Run Test button.
6. Move slider M1 to approximately 8,000.
7. Move slider M2 left and right until the smoothest running condition is reached.
8. Move slide M1 left and right until the smoothest running condition is reached.
9. Press Stop Test.

X-Smoothness #3

10. Press the Run Test button.
11. Move slider H1 left and right until the smoothest running condition is reached.
12. Move slider H2 left and right until the smoothest running condition is reached.
13. Press Stop Test.
14. Click OK.
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Advanced (Advanced Tuning)

The Advanced tab allows you to enable/disable and modify various advanced performance features 
of the Impulse drive. 

Anti-Resonance

• Enable this feature by selecting the Enabled check box. Ensure that both Damping Gains 
are configured if Anti-Resonance is enabled.

Current Reduction Mode

• Select Stop to enable the stop mode current reduction time-out period. Stop Mode reduces 
current by 25%. This time-out period is directly entered in milliseconds. The valid range is 
6 to 19,656 ms.

• Select Idle to set the idle mode current reduction time-out period. This time-out period is 
directly entered in seconds. The valid range is 0 to 3600 seconds (0 = disabled).

• In the % box, enter the percentage that current will be reduced after the idle mode time-
out has expired. The valid range is 0 to 100%.

Profiling 

• Select Dynamic Smoothing Enabled by clicking on the check box and entering the recom-
mended gain in the input box. Dynamic Smoothing™ is an IDC proprietary method of auto-
matically reducing “jerk” (sudden change of acceleration) which is often inherent in move 
sequences generated by indexers. Dynamic Smoothing™ is similar in effect to so-called S-
curve profiles. The softening of accel/decel transients sharply reduces ringing in the motor 
and various attached structures.

• Select Multi-Stepping Enabled for more aggressive dynamic smoothing. Gain will be 
1/10 of the recommended gain when Dynamic Smoothing is enabled. Multi-Stepping™ is 
an IDC proprietary method of obtaining very smooth motion from step motors when using 
low resolution indexers, i.e. 200, 400, 1000 steps/rev. The Multi-Stepping™ feature, when 
enabled, executes coarse stepping regimens by using microsteps to fill-in between the 
widely-spaced, low-resolution steps. This is a form of interpolation that produces smooth 
motion in an otherwise coarse and noisy stepping system.

Note: Observe decrease in 
Gain when Multi-Stepping is 
Enabled.
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Stall Detection

• Select Stall Detection to enable the Open Loop Stall Detect™ encoderless stall detection 
feature. 

• Stall detection becomes active at velocities of 0.5 RPS and greater.

Remember to perform a “Send All” command to send the modified project file to 
the drive.

I/O Setup

After configuring the Axis Setup parameters, the discrete inputs (4 ea.) and output (1 ea.) will need 
to be configured for your application. See I/O Descriptions below for details.

• Click on the I/O Setup tool bar button.

• Select up to four Discrete Inputs and one Discrete Output from the pulldown menus.

• Use the toggle buttons to right of the inputs to select between Active Low (A.L.) and Active 
High (A.H.).

I/O Descriptions
Input Descriptions

EOT (End of Travel): Activation of an End of Travel input during any motion (external steps or 
internal move engine) will terminate motion at the rate specified by the Stop Rate parameter, and 
latch the direction. Motion is only allowed in the direction opposite of the latched EOT direction 
until a negative edge (activation on to activation off) is made.  This guards against the switch 
activator becoming “trapped” if the Stop Rate was insufficient to stop motion in the activation 
region.  The EOT input is also required in the execution of Home type moves.  See Stored Move 
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Setup - Editing Stored Moves later in this chapter for more information on Home moves.

Jog +: Activation of a Jog+ input will jog the motor at the acceleration rate specified by the Jog 
Accel parameter and the velocity specified by the current state of a Jog Speed input in the positive 
direction.  If a Jog Speed input has not been configured, the motor is jogged at the velocity specified 
by the Jog-Low parameter.

Jog -: Activation of a Jog- input will jog the motor at the acceleration rate specified by the Jog Accel 
parameter and the velocity specified by the current state of a Jog Speed input in the negative 
direction.  If a Jog Speed input has not been configured, the motor is jogged at the velocity specified 
by the Jog-Low parameter.

Jog Speed: The Jog Speed input toggles between the low and high velocities for the Jog+ and Jog- 
inputs as specified by the Jog-Low and Jog-High parameters.  If the state of Jog Speed input is 
changed while a Jog+ or a Jog- input is asserted, the motor will accel or decel at the Jog Accel rate 
to the high or low velocity respectively.

Kill: Activation of a Kill input terminates any motion (external steps or internal move engine) 
instantly without a deceleration ramp.

Move Select: The Move Select input is used to trigger one of the 7 possible stored moves (Motion 
Node option only). Each configured Move Select input serves as a bit in a 3-bit binary number 
therefore allowing the binary representation of numbers 0-7. The Move Select configuration option 
is only available on inputs #1-#3 with input #1 being the least significant bit (LSB) and input #3 
being the most significant bit (MSB). Note that the bit places are fixed with respect to the input 
numbers. For example, if input #1 were configured as an EOT and input #2 were configured as a 
Move Select, asserting input #2 would run stored move #2 not stored move #1. Below is a Move 
Select assertion table:

To guard against inadvertently selecting moves during input transitions, all Move Select inputs must 
be stable for the time specified by the Move Select Input Scan Time. See the “Editing Stored Moves” 
section for more information on setting the Move Select Input Scan Time.

Stop: Activation of a Stop input terminates any motion (external steps or internal move engine) at 
the rate specified by the Stop Rate parameter.

Warm Boot: Activation of a Warm Boot input resets the drive and clears any latched fault 
condition. To guard against a Warm Boot input being inadvertently held asserted, the Warm Boot 
input is negative edge triggered (activation on to activation off). To insure the negative edge is 
latched, the Warm Boot input must be held asserted for at least 500µs before releasing.

Move Select Inputs
Input #3 State Input #2 State Input #1 State Result

Inactive Inactive Inactive Idle
Inactive Inactive Active Run Stored Move #1
Inactive Active Inactive Run Stored Move #2
Inactive Active Active Run Stored Move #3
Active Inactive Inactive Run Stored Move #4
Active Inactive Active Run Stored Move #5
Active Active Inactive Run Stored Move #6
Active Active Active Run Stored Move #7
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Output Descriptions
Brake: The Brake output is activated on any fault condition.  This provides a control signal to 
engage a brake when the Impulse loses torque due to a fault.  The Brake output also provides a 
polarity-configurable fault output since the dedicated fault output is fixed as an active high, sinking 
output.  Note: The Brake output is not intended nor designed as a power source for a mechanical 
brake.

In Motion: The In Motion output is activated upon receiving incoming step pulses or when a stored 
move (Motion Node option) is running.  The minimum step frequency that the internal velocity 
tachometer can render is 156.25 Hz (156.25 / Step Resolution in RPS).  Input step frequencies below 
156.25 Hz will not activate the In Motion output.

Stall: The Stall output is activated when OLSD™ (Open Loop Stall Detect) detects a motor stall.
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Stored Move Setup - Editing Stored Moves

If your Impulse is equipped with the Motion Node option you will be able to access the Stored 
Move Setup menu shown below. The Impulse will store seven (7) moves which can be invoked 
through binary inputs, by serial commands (see Appendix B), or via the Run > Stored Move 
window. Moves are edited in the Stored Move Setup window via Edit > Stored Move or the Edit 
Stored Moves tool bar button.

• Click on the Edit Stored Moves button.  

• Use the information provided below to configure your Stored Moves in the Stored Move Setup 
menu.

Stored Moves are defined by the parameters Accel (acceleration rate), Decel (deceleration rate), 
Velocity, Position/Distance, and Move Type. Distance Units pertaining to the four dynamic 
parameters are selected in the Project Wizard or the Axis Setup tab (Setup > Axis > Mechanics > 
Change Mechanical System/Units). The three move types are Incremental, Absolute, and Home, 
each selectable by a radio button.

Incremental moves are indexed to the commanded position from the current position.
Absolute moves are indexed to the commanded distance.
Home moves function as follows:

1. The drive moves at the specified velocity (direction selected by velocity sign) until it sees an 
EOT input go active.

2. On the active going transition, the drive decelerates according to the specified Stop Rate 
parameter.

3. The drive reverses direction and moves at 1/16 of the specified Velocity until it sees an active-
to-inactive transition on the EOT input. This locates the inside edge of the EOT sensor precisely.

4. The drive stops the slow move and executes an incremental move defined by the Distance entry. 
This final move is always in the opposite direction to the initial search direction specified by the 
sign of the Velocity parameter. This move constitutes an offset from the edge of the EOT sensor.

5. After the final position is reached, the drive zeros its position counter. All subsequent “absolute” 
moves will be relative to this Home position.
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Note: Homing is predicated on the assumption that the system is positioned somewhere 
between the EOT switches when the home move is invoked. If the system is initially outside the 
interval between the EOT switches, the homing routine will fail in one of two ways: (1) carriage 
will be driven against mechanical end-stop. (2) carriage will end up “homed” outside the 
interval between the EOT switches.

Digital inputs are configurable as EOT (Active High/Active Low) on the Setup > I/O menu. 
More than one Home move can be specified and stored simultaneously if it serves a purpose.

Input Scan Time - This is the time the drive requires the binary input selection to be stable prior to 
triggering a move. Its primary purpose is for debouncing inputs. Scan time can be configured from 
0 to 19,656 milliseconds.
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File Menu

• Selecting New Project will take you to the Project Wizard.

• The default file suffix is *.idc.

• Project files may be stored on disk as DOS files.

• All other selections under the File menu are generic to all Windows applications.

Edit Menu

• Stored Move and Motor File Editors, both discussed previously, can also be accessed from 
the menu bar. 

Setup Menu

• I/O, Axis, and Project Wizard, accessible from toolbar buttons, have been discussed previ-
oulsy.

• Select Controller Type as the first step in starting a new project file. You must select a con-
troller before you can build a new project file.
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Communications Menu

• Use Send All  to download a project file to the drive. A Send All toolbar button is also avail-
able.

• Use Retrieve All to upload a project file from the drive for modification.

• Project Update allows you to accelerate the configuration of multiple drives when all drives 
have the same setup configuration. After configuring your first drive with the Project Wizard, 
select Project Update and follow the onscreen prompts for each additional drive.

• Change Unit Number is used to set the unit address of each 
drive to be used on a daisy chain. Each drive must have its own 
unique software address. The unit number must be set before the 
units are connected in the daisy chain.

Press Query Address if the address is unknown. This feature 
can only be used with a single drive connected to the computer. 
An attempt to Query Address of a unit on a daisy chain will 
result in an error message.

• Setup Comm Port is used to select a Comm Port when your PC 
has multiple serial ports. This dialog box also contains a Comm Port test utility to verify proper 
RS-232/485 operation.

• Select Test Connection to command an instant communication test (also available in Setup 
Comm Port).

• For information on Load Flash Memory, see Updating Your Impulse Operating System at 
the end of this chapter.
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Run Menu

• The Run > Stored Move menu is available only on drives equipped with the Motion Node 
option and can only be accessed from the menu bar. This menu allows you to view all stored 
move profiles and to run and stop each stored move.

• No editing of moves is available on this menu. During the execution of any stored move, the 
Impulse ignores the step and direction inputs. Any activity on those inputs is completely lost. 
In other words, stored moves are not added in with incoming step commands. Typically, it is 
not a useful control stratagem to trigger a stored move while engaged in motion commanded 
via the step and direction inputs.

• Binary inputs (digital inputs 1, 2, and 3) may be configured as Move Inputs (Active High/
Active Low) for triggering stored moves (Setup > I/O). 

• Serial Commands - A host system may trigger moves over the serial RS-232/485 connection. 
This procedure involves the transmission of Unit Addressing, Parameter Indexes, Data and 
Checksum. The advanced topic of serial communications protocol is covered separately in 
Appendix B.  

• Click on Probe Motor to probe the motor at any time. Probe the motor when a steady red LED 
is present.

• Select Jog Motor to access the jog utility shown below. Jog Low and Jog High may be 
changed for immediate effect but the configured input speeds (set in the Axis Setup > Com-
mand menu) will not be changed. The center button toggles between High and Low speeds, 
and the arrow buttons change motor direction.

• Click on Reset Impulse to clear a fault. Reset is a warm boot.
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View Menu

• Select Configuration Text File to see your system 
configuration status. All configuration parameters are 
listed and may be viewed by scrolling the list.

• Select Control Status for a quick look at current I/O configuration, motor position and veloc-
ity, fault history, and basic internal drive information (i.e. firmware version, etc.).

• Click Drive Info for a look at hardware and firmware versions. In the unlikely event that 
the Impulse sustains an EEPROM Fault (7 red LED flashes) the Restore Factory Settings 
button is used to clear the current memory contents and restore the factory default configu-
ration of the Impulse.

• Click Fault History to look at the eight most recent drive faults, accumulated hours of 
operation, and the number of power cycles.

• Click Refresh to get a quick snapshot of the Drive Status.

• Press the Poll button to continuously check drive status. Stop Polling turns polling off and 
restores the Refresh button.

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 4 - Configuring Impulse with Application Developer

4-27

Updating Your Impulse Operating System:

Your Impulse drive contains FLASH memory technology allowing the flexibility and convenience 
of upgrading the operating system using Application Developer and a PC RS232 or RS485 serial 
connection.  The latest released Impulse operating system version is available for download at our 
web site http://www.idcmotion.com.

NOTE:  Upgrading the operating system will reset the drive setup to factory default settings.  Be 
sure to save the drive setup as a .idc file or in a keypad before upgrading the operating system.

Loading the Operating System

1. Obtain the new operating system file from http://www.idcmotion.com or directly from the 
factory.

2. With a single Impulse drive connected, select Communications > Load FLASH Memory 
from Application Developer.

3. Use the Open File dialog box to select the desired .hex operating system file.

4. Application Developer will establish a FLASH memory connection and begin the transfer. The 
warning and progress screens (shown below) will appear when the FLASH transfer begins. 

WARNING:  Upgrading the operating system should only be performed when instructed by
the factory.  The potential for FLASH corruption exists if the operating system upgrade is
interrupted while in progress.  If the FLASH memory becomes corrupted, it will need to be
reprogrammed at the factory.

WARNING:  DO NOT attempt to load the operating system over an RS232 daisy chain or
RS485 bus. Attempting to load multiple units simultaneously will result in a FLASH cor-
ruption of all units.
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Chapter 5 - Configuring Impulse with an IDC Keypad

Section 1 of this chapter is intended primarily to familiarize new IDC keypad users with the FP100 
Impulse Keypad, and we recommend this section be reviewed by those experienced with the FP220 
keypad as well. If you are using an FP220 keypad (version 3.00 and above) to configure the Impulse, 
it is imperative that the keypad DIP-switches be set as shown on the next page.

Section 2 provides step-by-step procedures for configuring the Impulse with either the FP100 or 
FP220 keypad.

Section 1 - Introduction to the FP100 Impulse Keypad

The FP100 version of the IDC keypad was developed solely for the Impulse drive, while the FP220 
(version 3.00 and higher) can also be used with the Impulse and with IDC’s extensive line of Smart 
Drives. The FP100-RS485 and FP220-RS485 keypads may be used with an Impulse and RS-485 
communication.

The keypad was designed to provide operators with a convenient way to configure an application, 
and though it functions primarily as an operator interface, it is also effective as a troubleshooting 
tool.

Application Note: If a project file was created in Application Developer using the Extended level 
of Numeric Precision (Axis Setup > Command > Numeric Precision > Extended), you will receive 
a precision error message when the file is loaded into a keypad. Only the Standard level of numeric 
precision (Axis Setup > Command > Numeric Precision > Standard) is compatible with the precision 
level of the keypad. See Chapter 4, Configuring Impulse with Application Developer.

Keypad Features

• Easy-to-read, two-line, 40-character, 
back-lit display

• Can be sealed to IP65 (NEMA 4) wash-
down environment

• Large, scratch-proof keys with audible 
and tactile feedback

• Connects to the Impulse with a remote 
cable

• Allows project files to be copied to and 
from a PC.
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Keypad Hardware Features

Adjusting Contrast
On the back of the keypad there is a plastic potentiometer, adjustable with a flathead screwdriver. 
This is used to adjust the contrast on the LCD display. If the Impulse drive and keypad were 
purchased together, this adjustment has been made by IDC. Some adjustment may still be necessary 
to accommodate a variety of lighting conditions or viewing angles.

Remote-Mounting the Keypad
The keypad can easily be mounted and sealed to NEMA 4 specifications by using the included 
mounting gasket and 6-foot communication cable. See Chapter 6, Hardware Reference, for 
important information on mounting the keypad and extending cable length.

DIP Switch Settings
DIP-switch settings on the back of the FP100 keypad have no effect on either the keypad or the 
Impulse drive.

NOTE: If you are using an FP220 keypad with your Impulse, you must set DIP-switch #3 to the ON 
position and switch #s 1, 2, and 4 to OFF.  Setting switch #3 to ON does not apply when using the 
FP220 with other IDC drives or controls. See appropriate user’s manual or call IDC Applications 
Engineering for information on keypad applicability.

Back of Keypad 

12345

+5VDCRXGND TXN/C

Keypad Connector Pins

ON

1 2 3 4

ON

1 2 3 4

DIP Switch Contrast

FP220 Settings (#3 ON)
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Functions of the FP100 Keypad Keys

DECIMAL POINT
Used to enter fixed-point 

numbers.

.

RUN - Runs a program, jogs 
an axis, or accesses Test/
Debug functions.

EDIT - Edits Setup parame-
ters and programs, lists pro-
grams, & resets position 
counter.

HELP - Provides help on 
keys, menus, and command 
syntax.

COPY - Copies one program 
to another within a control.

DEL - Deletes characters in 
the editor or deletes entire 
programs from memory.

Menu Keys
RUN - Run stored moves, 

probe and jog the motor, 
warm-boot the drive, and 
enable/disable software 
shutdown. 

EDIT - Configure and tune 
the setup and stored move 
parameters. Select, edit, 
and load project files.

HELP - Displays keypad, 
firmware, and hardware ver-
sions. Shows drive and I/O 
status, and fault history. 

COPY - Copies project files 
to and from a drive.

DEL - Deletes project files or 
characters in a text-entry 
editor.

DECIMAL POINT
Used to enter fixed-point 
numbers when the text-
entry editor allow it.

COMMA
May be used in file names.

ENTER
Selects project files and 
saves edits to project files 
in the File Options menu.

0-9 Keys
Enters numbers directly, and 
letters when preceded by the 
ALPHA key.

F Keys (F1-F2-F3)
Used as menu or sub-menu item 
selectors. 

←↑→ ↓
For scrolling through menu 
options, setup choices, and 
files in the editor.
Moves motor in JOG mode.

ALPHA
ALPHA plus a numeric key 
selects alphabet charac-
ters, for example:
ALPHA +1 selects A,
ALPHA +1+1 selects B

ALPHA
ALPHA plus a numeric key 
selects alphabet characters.  
Pressing:
ALPHA >1 enters “A”
ALPHA >1>1>1>1 enters “a”

ESC
Saves an entry and moves back 
one menu level.

±
Serves as a minus or 
hyphen key on the 
FFP100 keypad. The 
+ symbol is not avail-
able on the FP100.
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Keypad Menu Structure

Most operations using the keypad are menu-driven. A menu consists of a title bar on the top display 
line and as many as three options (or sub-menus) at a time on the bottom display line. Each option 
is displayed above one of the function keys, F1, F2, or F3.  Press a function key to select the 
corresponding option.

If a menu has more than three options, arrows will appear on both sides of the display to indicate that 
more options are available.  Press the appropriate arrow key to scroll, one display at a time, through 
all options in that menu. To exit a menu without making a selection, or to back up one menu level, 
press ESC.

The following table shows the Menus which are accessible from the Main Display by pressing the 
RUN, EDIT, HELP, COPY and DEL keys:

FP100 Main Menu and Sub-Menus 

MOVE  (F1)
Run a stored move

FILE  (F1)
Open, Save, or 
Rename a Project 
File

START  (F1)
N/A on FP100

TO PAD  (F1)
Send project file to 
the drive

Delete a project file 
or a character in the 
EDIT > FILE sub-
menus

PROBE  (F2)
Probe the motor for 
internal characteris-
tics

SETUP  (F2)
Configure system 
components and 
operating limits

VERSN  (F2)
Provides Operating 
System, Hardware, 
and Keypad Ver-
sion numbers

FROM PAD (F3)
Retrieve project file 
from the drive

JOG  (F3)
Jog motor at LOW 
(F1) or HIGH (F2) 
speeds

MOVE  (F3)
Optional Feature 
Configure and edit 
stored moves.

STATUS  (F3)
Provides I/O, Drive 
Status, and Operat-
ing History of the 
Impulse

WMBOOT (F1)
Reset the drive with-
out cycling power

UNIT#
Configure Impulse 
unit number for use 
in a daisy chain

SHTDWN (F2)
Enable/disable soft-
ware shutdown

Menu
Options
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Apply Power to the Keypad

Power is supplied to the FP100 keypad through its connection to the Impulse COM PORT. Note: If 
you are using an FP100-RS485, see Chapter 3, Section C for connection procedure.

When power is first applied to the keypad (prior to any menu 
being selected) you should observe the display shown on the 
right. The top line of the display shows the device your keypad is 
connected to (Impulse or PC), while the bottom line shows the 
open project file name and status. Note: If your Impulse is 
equipped with the optional Motion Node, the top line of the 
display will read: CONNECT: Impulse  MN

File status is indicated by an asterisk (*). If and asterisk appears next to the file name, this indicates 
that the data in the open file has not been sent to the drive. The asterisk disappears when a COPY > 
TO PAD or a COPY > FRM PAD is performed. The asterisk reappears when a new project file is 
opened or when changes have been made to the currently open project file. See Using the EDIT 
Menus in this chapter for opening, saving, and naming files

General Rules for Using the Keypad

Entering Characters with the ALPHA key
The ALPHA key allows you to enter alphabet characters into a project file from the keypad. The 
ALPHA key acts as a toggle button between the alphabet characters and the number on a key

• Any letter located above a number on a numeric key may be inserted into a file name, i.e. the 
A, B, or C on the top part of the #1 key.

• You must press ALPHA prior to each letter you wish to enter. You must press ALPHA again if 
you want to enter a number immediately following the letter, hence .

• Press a key 1, 2, and 3 times to enter the upper case letters.

• Press a key 4, 5, and 6 times to enter the lower case letters.

• Press the ← or → arrow keys to move the cursor to the next space.

ESC Key
Use the ESC key to save an entry or selection and move back one screen on the display.

ENTER Key
Use the ENTER key to select or save a file in the FILE OPTIONS MENU.

Sending the Factory Default Configuration to the Impulse
In the unlikely event that the Impulse sustains an EEPROM Fault (7 red LED flashes), this fault can 
be cleared by restoring the factory default configuration. To restore the default configuration:

1. Press the decimal key.

2. Press the right arrow key.

3. Press the DEL key.

CONNECT:  Impulse
FILE: untitled *
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Using the RUN Menus

Press the RUN key to display the MOVE, PROBE, JOG, 
WMBOOT, and SHTDWN menus.

Run Stored Move (MOVE)
Note: The MOVE feature is available only if you purchased the 
optional Motion Node version of the Impulse

RUN > MOVE allows you to select and run one of the seven 
stored moves in the drive. Once a move is selected, the move will run until completion, or the move 
can be stopped at any time by pressing the ESC key. See Move Menus - Using Stored Moves, later 
in this chapter, to configure stored moves.

Probe the Motor (PROBE)
RUN > PROBE allows a quick motor probe when a steady red 
light is present on the LED diagnostic indicator.

Jog Motor (JOG)
RUN > JOG allows you to jog a properly configured motor. The 
distance is displayed in the units selected under EDIT > SETUP 
> MECH > UNITS, and the default velocity is HIGH. 

The jog velocities and jog acceleration are defined under EDIT > SETUP > COMAND > JOG. The 
motor is jogged by pressing and holding the direction-respective arrow key. The motor is stopped by 
releasing the arrow key.

Warm Boot System (WMBOOT)
RUN > WMBOOT will reset the drive without recycling power.

Disable Amplifier (SHTDWN)
RUN > SHUTDWN allows you to override the hardware 
SHUTDOWN input for disabling the drive only. If the hardware 
input has asserted an amplifier shutdown, this feature will not 
override the input to enable the drive.

RUN

 −−−−−−↑ ↑ ↑ ↑   RUN   ↓−−−−−↓−−−−−↓−−−−−↓−−−−−
MOVE     PROBE    JOG

 −−−−−−↑ ↑ ↑ ↑   RUN   ↓−−−−−↓−−−−−↓−−−−−↓−−−−−
WMBOOT   SHTDWN

 −−−↑ ↑ ↑ ↑   RUN   MOVE ↓−−↓−−↓−−↓−−
1               2              3

Probing Motor...............

JOG:   0.0 Revs
  LOW       <HIGH>

Warm Booting.............

 −− Software Shutdwn −−−−−−−−
↑        ↑        ↑        ↑        ENABLED        ↓↓↓↓
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Using the EDIT Menus

Press the EDIT key to display the FILE, SETUP, MOVE, and 
UNIT# menus. 

File Menu (FILE OPTIONS)

The FILE menu allows you to select, save, and name or rename your project files. 

Opening a Project File
This option allows you to select one of eight (8) stored project files. All eight project files are 
initialized to the default configuration and are named “untitled”. The project files are selected by 
scrolling the names up or down using the arrow keys.

Saving a Project File
This option allows you to save a project file. If a custom project file has not been selected since the 
keypad was powered-up, you will be prompted to select a project file location (file #) to overwrite. 
A project file location is selected by scrolling the filenames using the up or down arrow keys and 
pressing the ENTER key. Once a project file is selected, you will be prompted to enter a new name 
for the file.

Project file names may consist of a combination of numeric digits and alphabet letters and are limited 
to 10 characters. Alphabet characters are accessed by pressing the ALPHA key and repeatedly 
pressing the numeric key until the desired letter is displayed on the screen. Use the right and left 
arrow keys to move the cursor.

If a custom project file is currently open, you will be prompted to overwrite the currently open 
project file. If YES is selected, the open project file will be overwritten with the data currently in the 
keypad. If NO is selected, you will be prompted again to select a project file location to overwrite 
and rename if desired.

EDIT

 −−−−−−↑ ↑ ↑ ↑   EDIT   ↓−−−−−↓−−−−−↓−−−−−↓−−−−−
FILE        SETUP     MOVE

 −−−−−−↑ ↑ ↑ ↑   EDIT   ↓−−−−−↓−−−−−↓−−−−−↓−−−−−
UNIT#

> FILE EDIT  −−−  −−−  −−−  −−− FILE OPTIONS −−−−−−−−−−−−
OPEN   SAVE   RENAME

> FILE > OPEN EDIT  −−−↑   −−−↑   −−−↑   −−−↑  Select File  ↓−−−↓−−−↓−−−↓−−−
1: untitled

> FILE > SAVE  EDIT  −−−↑   −−−↑   −−−↑   −−−↑  Select File  ↓−−−↓−−−↓−−−↓−−−
1: untitled
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Renaming an Open Project File
This option allows you to rename (or name) the currently-open project file. Project file names are 
entered using a combination of the ALPHA and numeric keys. Project file names consist of numeric 
digits and alphabet letters and are limited to 10 characters. Alphabet characters are accessed by 
pressing the ALPHA key and repeatedly pressing the numeric key until the desired letter is displayed 
on the screen. Use the right and left arrow keys to move the cursor.

If RENAME is selected and a project file is not open, an error message will be displayed. 

Using the SETUP Sub-Menus for Configuring Your System

The following table shows the structure within the EDIT > SETUP sub-menu. For more detailed 
descriptions of setup parameters, see Chapter 5 - Configuring Impulse with the FP100 or FP220 
Keypad.

Sub-Menu Setup Parameter Description of Setup Parameter
COMMAND Direction Positive or negative motor direction

Shutdown Active Low or Active High polarity

Drive Resolution Operating step resolution

Stop Rate Deceleration rate

Jog Acceleration/Deceleration, and High/Low Jog speeds

MOTOR Probe the Motor Probes for motor characteristics and sends 1 kHz tone

Motor Type IDC motor type

Motor Current Operating current

MECHANICS User Units Choose inches or millimeters, or toggle between revolutions 
and steps

Units Gear Ratio Units scaling ratio for distance, velocity, and acceleration

TUNING X-SM1, X-SM2, X-SM3 Empirical fine tuning of the X-Smoothness

ADVANCED Anti-Resonance Anti-resonance gain settings

Profiling Enabling Multi-Stepping and Dynamic Smoothing

Stop Reduction Timeout Set the stop mode current reduction timeout period

Idle Mode Reduction Set the idle mode current reduction timeout period

Stall Detection Enables Open Loop Stall Detect

I/O Input Configure 4 inputs

Output Configure 1 output

Polarity Select Active High or Active Low polarity

> FILE > RENAME  EDIT     Requires Open File
OK
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Using the HELP Menu

Versions
• Press the HELP > VERSN (F2) for access to Operating 

System, Hardware, and Keypad versions (see examples on 
the right).

• Press F1, F2, or F3 for respective version displays.

• Press the ESC key to exit the HELP menu.

Status
• Press HELP > STATUS for I/O configurations, current 

drive status, and the operating history of the drive.

• Press I/O to check the configuration of four discrete inputs 
and one output.

• Press DRIVE for current drive status. The example shows 
no fault condition.

• Press HISTRY for the following operating histories: num-
ber of hours in operation, number of power cycles, and last 
eight drive faults.

• Press HR_OP for the total number of hours the Impulse 
has been in operation.

• Press PWR_CY for the number of times power has been 
cycled.

• Press FAULT to look scroll through the last eight (8) drive 
faults. Stored Fault #1 is the most recent fault.

HELP

−−−−−−  −−−−−−  −−−−−−  −−−−−−  HELP  −−−−−−−−−−−−−−−−−−−−−−−−
START   VERSN  STATUS

VERSIONS 
OPSYS   HDRWAR   KPAD

OpSystem Version
vXXX

Hardware Version
AMP: E0     I/O  F0

Keypad Version
vXXX

STATUS
I/O       DRIVE    HISTRY

  In1   In2   In3   In4   Out1
OFF  OFF OFF OFF OFF

System is Enabled
FAULT: ✻✻✻✻

OPERATING  HISTRY
HR _OP     PWR_CY    FAULT

Hours Operation
XXX.XX

Num Power Cycles
XXX

↑↑↑↑    Stored  Fault #1   ↓↓↓↓
Overcurrent (example)
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Using the COPY Menu

Downloading project files between keypads and Impulse or between keypad and PC can save a 
significant amount of time when configuring your drive with an FP100 keypad.

Press COPY for the following two options:

FROM PAD
This option allows you to send the currently open project file to the 
drive. Answering YES to the send prompt will send the open 
project file and overwrite the current setup in the drive.

TO PAD
Allows you to retrieve the current setup from the drive. Answering 
YES to the retrieve prompt will extract the project file from the 
drive and make it the “open” file in the keypad. The extracted file 
is not saved to non-volatile memory and must be saved under EDIT 
> FILE > SAVE if the data is to be stored.

Application Note: Keypads do not provide the same decimal-level precision as IDC’s Application 
Developer software. A project file created at higher precision will cause a “precision error message” 
when loaded into a keypad.

Using the DEL (Delete) menu

To Delete a Project File
1. Press DEL.

2. Using the up and down arrow keys, select the project file to 
be deleted by scrolling through the list of eight (8) existing 
files.

3. Press ENTER to select the file to be deleted. Confirm 
deletion by pressing YES or NO.

To Delete a Single Entry in the EDIT > FILE > RENAME File Editor:
1. Move the cursor over the entry you wish to delete (move with ←  or →).

2. Press DEL.

COPY

COPY
TO PAD           FRM PAD

Send Current Setup?
YES                       NO

Retreve Drive Setup?
YES                       NO

DEL

- -  ↑↑↑↑    Select  File   ↓↓↓↓   - -
1: untitled

Delete File?
   YES                              NO
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Section 2 - Configuring Impulse with an IDC Keypad

This chapter contains information and steps for developing an Impulse project file with the FP100 
keypad. Configuring all parameters in the EDIT menu will ensure that your project file is setup 
correctly.

The task of configuring your Impulse for a specific application consists of customizing a number of 
software parameters to match the mechanics of the system. These parameters include motor setup, 
I/O, jog, stored move profiles, and advanced tuning.

Application Note: If a project file was created in Application Developer using the Extended level 
of Numeric Precision (Axis Setup > Command > Numeric Precision > Extended), you will receive 
a precision error message when the file is loaded into a keypad. Only the Standard level of numeric 
precision (Axis Setup > Command > Numeric Precision > Standard) is compatible with the precision 
level of the keypad. See Chapter 4, Configuring Impulse with Application Developer.

The configuration procedures in this section will follow the format of the example below:

Parameter Being Configured (example: Motor Type)

1. Using ↑ ↓ arrow keys, scroll the list of motors and stop when the your motor appears.

2. Press ESC.

> SETUP > MOTOR > TYPEEDIT −−−↑−−−↑−−−↑−−−↑  Motor Type  ↓−−−↓−−−↓−−−↓−−−
None

ypad
eps

  

4.  Follow these steps to configure this parameter 

 

1. Press EDIT, then SETUP, then MOTOR, then TYPE
 

2. You will see this display on the keypad

 

3. Default configuration, if any, will be shown on the bottom line of the display
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Configuring Impulse with the Keypad

Open a File
Using the EDIT > FILE menu, open a project file.

Using the EDIT > SETUP Menus to Configure the Impulse
The EDIT > SETUP menus allow you to configure your motor, 
mechanical units, I/O, operating characteristics, and perform 
advanced tuning of your system for optimum performance. 

MOTOR SETUP
Configuring Motor Type

This menu allows you to select a preconfigured IDC motor type. In addition to IDC motor types, the 
keypad can store one custom motor type. The keypad does not contain a motor editor, so custom 
motor types must be created using the Application Developer *motor editor, then loaded into the 
keypad via a project file.

*See Application Developer > Axis Setup > Motor Tab > Edit Motor

1. Using ↑↓ arrow keys, scroll the list of motors until the desired motor appears on the bottom line.

2. Press ESC to save your motor selection.

Probing the Motor
A new drive setup must be instructed to probe itself after you have selected motor type on the keypad 
(procedure on next page). The internal setup parameters obtained during the motor probe are stored 
in nonvolatile memory so that the process need not be repeated every time the power is cycled. 

Each time a different type of motor is connected to the drive, the motor must be probed. The drive 
should always be reconfigured for a new motor to avoid degrading the anti resonance feature and 
OLSD™. When the drive is probing the attached motor, a short 1 kHz tone will be heard emanating 
from the motor. Depending on motor type, this tone may persist for anywhere from several seconds 
to half a minute.

The motor probe may be initiated (1) immediately after configuring motor type, or (2) after all 
parameters in the EDIT menus have been configured. In either case, the following procedure applies:

−−−−−↑−−−−−↑−−−−−↑−−−−−↑ SETUP ↓−−−−−↓−−−−−↓−−−−−↓−−−−−
COMAND MOTOR MECH

−−−−−↑−−−−−↑−−−−−↑−−−−−↑ SETUP ↓−−−−−↓−−−−−↓−−−−−↓−−−−−
TUNING  ADVNCE   I/O

> SETUP > MOTOR  EDIT  −−−↑ −−−↑ −−−↑ −−−↑ Motor Type ↓ −−−↓ −−−↓ −−−↓ −−−
−−−  −−−  −−−  −−−  None  −−−−−−−−−−−−
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To Probe the Motor:
1. Return to the initial keypad display (no menu selected).

2. Press RUN > PROBE (F2). At the end of the 1 kHz tone, the 
motor has been probed.

3. Press ESC.

4. Continue configuring the EDIT Menu parameters if they 
have not been completely configured, or go to step 5.

5. Press COPY > FRM PAD (F3) to send the project file to the drive. Your project file now 
contains parameters vital to the advanced performance features of the Impulse.

COMMAND SETUP
The following five parameters are configured in the COMMAND sub-menu:

DIR  Motor Direction (POSITIVE=CW or NEGATIVE=CCW) 
SHDWN Shutdown Polarity (ACTIVE LOW or ACTIVE HIGH)
D-RES Drive Resolution (steps/rev)
STPRTE Stop Rate (user-units2)
JOG Jog Parameters (ACCEL, LOW VELOCITY, or HIGH VELOCITY)

Configuring Motor Direction

1. Press the ↑ ↓ arrow keys to select the POSITIVE (CW) or 
NEGATIVE (CCW) motor direction.

2. Press ESC.

Configuring Shutdown Polarity

1. Press the up or down arrow key to select ACTIVE LOW (default) or ACTIVE HIGH.

2. Press ESC.

Probing Motor.............

> SETUP > COMAND  EDIT −↑−↑−↑−↑ COMMAND SETUP ↓−↓−↓−↓−
   DIR   SHDWN   D-RES

−↑−↑−↑−↑ COMMAND SETUP ↓−↓−↓−↓−
   STPRTE   JOG

> SETUP > COMAND > DIR EDIT - Motor    Direction - 
↑            ↑            ↑            ↑            POSITIVE          ↓↓↓↓

> SETUP > COMAND > SHDWN EDIT -  Shutdwn  Polarity  -
↑    ↑    ↑    ↑       ACTIVE LOW       ↓↓↓↓
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Configuring Drive Resolution

1. Using the numeric keys, enter the operating step resolution. The valid range for drive resolution 
is 200 to 100,000 in increments of 200 (divisible integer of 4X the tooth count of the motor).

2. Press ESC.

Configuring Stop Rate
This option allows you to define the deceleration rate to be used when a STOP or EOT input is 
activated or the ESC key is pressed. The units are user-defined in units2 and the valid range is 0.1 to 
1000.00.

1. Using the numeric and decimal keys, enter the desired stop rate. Note: this value will be in units 
selected in EDIT > SETUP > MECH > UNITS > User Units

2. Press ESC.

Configuring Jog Parameters
This option allows you to modify the jog parameters which are used by the Jog inputs (JOG+, JOG-
, JOG SPEED), and in the RUN > JOG menu of the keypad. The parameters to be configured are:
ACCEL = Jog Accel/Decel (default = 20 User-Units2)
LOW_V = Jog Low Speed (default = 0.50 User-Units)
HIGH_V = Jog High Speed (default = 2.00 User-Units)

To enter a value for ACCEL (F1), LOW_V (F2), or HIGH_V (F3):

1. Press the F-key of the jog parameter being modified.

2. Using the numeric and decimal keys, enter the desired value. Note: this value will be in units 
selected in EDIT > SETUP > MECH > UNITS > User Units.

3. Press ESC.

> SETUP > COMAND > D-RES EDIT -  Drive  Resolution  -
25000

> SETUP > COMAND > STPRTE EDIT -----  Stop  Rate  ----
100.0 RPS2

> SETUP > COMAND > JOG EDIT JOG   PARAMETERS
ACCEL   LOW_V   HIGH _V
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MECHANICAL SETUP
The MECH SETUP menu allows you to configure (enter) the mechanical units and gear ratio for 
your application. Once configured, your keypad will use these units in all display and position 
reporting modes.

Configuring Mechanical Units (User Units)
This option allows you to select the units of distance, velocity, and acceleration used in the system. 
The units act only as a label and actual unit scaling is achieved by properly setting the gear ratio in 
EDIT > SETUP > MECH > RATIO. The unit of STEPS can be selected by toggling between REVS 
and STEPS (F3).

1. Press F1 for inches; press F2 for millimeters; or toggle F3 for revolutions per second or steps.

2. Press ESC.

Configuring Units Gear Ratio
This option allows you to enter the desired units-scaling-ratio for distance, velocity, and 
acceleration. The ratio is motor revolution per user unit. Note: If user units REVS or STEPS has been 
selected, the Units Gear Ratio will be a “Fixed Ratio.” Inches or millimeters must be selected to 
allow entry of a gear ratio (see “Configuring Mechanical Units above).

To change the Numerator (motor revs):

1. Press any numeric key and the Numerator value entry screen 
will appear. In the example to the right, #1 was pressed.

2. Enter the numerator value. Any number can be entered by moving the cursor to the left.

3. Press ESC.

To change the Denominator (user unit):

1. Press the right arrow key (→) and the Denominator value 
entry screen will appear.

2. Using the numeric keys, enter the numerator value.

3. Press ESC.

> SETUP > MECH EDIT MECH SETUP
UNITS   RATIO

> SETUP > MECH > UNITS EDIT User Units
[INCH]         MM      REVS

> SETUP > MECH > RATIO EDIT Units Gear Ratio
1    to   1

 - - - - Numerator - - - -
              1 _     

 - - - - Denominator - - - -
               _     
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MOTOR TUNING SETUP (X-Smoothness)
Fine-tuning of the motor is recommended for all applications and should be accomplished before 
the motor load is connected. Fine-tuning produces extremely smooth performance at 2 rps and below 
and is accomplished by configuring the three X-Smoothness components (X-SM1, X-SM2, and X-
SM3). 

Adjusting X-SM1 (X-SM2 and X-SM3 are adjusted using the same procedures)

VALUE

1. Press VALUE (F1) to enter the X-Sm1 value directly.

2. Using the numeric keys, enter a value for L1.

3. Press the down arrow key (↓ ) to access the L2 Value screen.

4. Enter a value for L2.

5. Press ESC.

TEST SPEED (TEST_SP)
This option allows you to modify the default test speed for 
component X-SM1. The speed is fixed in units of RPS. This 
component must be defined before moving to the next component, 
FINE adjustments.

1. Press TEST_SP (F2).

2. Using numeric and decimal keys, enter the test speed.

3. Press ESC.

FINE (Fine Adjustments)
This option allows fine adjustment of values L1 and L2 of X-
SM1. When this menu is entered, the motor will run at the test 
speed configured in the TEST SPEED option of X-SM1 (see 
above). Values L1 and L2 are selected by using the up and down arrows. The value is incremented 
(increased) by using the right arrow key (→) and decremented (decreased) by using the left arrow 
(←). Hold the arrow key down to increase/decrease the rate. The value is displayed on the right side 
of the display (display example shows 0). Stop the motor at any time by pressing ESC. If an 
adjustment has been made to values L1 or L2, you will be prompted whether or not to keep the new 
setting. Select YES to save the settings; select NO to restore the original settings.

1. Press FINE (F3).

2. Using the up and down arrow keys, select L1 or L2.

3. Using the left and right arrow keys, increase or decrease the Fine Adjustment value.

> SETUP > TUNING EDIT TUNING SETUP
X-SM1     X-SM2     X-SM3

> SETUP > TUNING > X-SM12 EDIT X-SM1 ADJUST
VALUE    TEST_SP   FINE

- ↑ ↑ ↑ ↑ X-Sm1  L1  Value ↓ ↓ ↓ ↓ -
0

- ↑ ↑ ↑ ↑ X-Sm1  L2  Value ↓ ↓ ↓ ↓ -
0

-     X-Sm1  Test Speed    -
0.0 RPS

↑  ↑  ↑  ↑  [L1] ←←←←--∗∗∗∗ --→ → → → 0
↓   ↓   ↓   ↓   L2  ←←←←--∗∗∗∗ --→ → → → 0
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4. Press ESC.

5. Press YES (F1) to save the new settings, or press NO (F3) to 
restore the original settings.

Configure X-SM2 and X-SM3 using the same procedures as X-SM1 (i.e. VALUE, TEST SPEED, 
and FINE).

ADVANCED SETUP
The following parameters must be configured in the ADVANCED SETUP sub-menu:

Configuring Anti-Resonance Gain

GAIN 1
This option allows you to configure the anti-resonance gain (#1) between 0 and 32,767. Setting gain 
at 0 disables the anti-resonance feature, regardless of the GAIN2 setting.

1. Press GAIN1 (F1).

2. Using numeric keys, enter a gain of between 0 and 32,767.

3. Press ESC.

GAIN2 (required only if GAIN1 was configured)
This option allows you to configure the anti-resonance gain (#2) between 0.1and 25.0.

1. Press GAIN2 (F2).

2. Using numeric keys, enter a gain of between 0.1 and 25.0.

3. Press ESC.

Keep New Settings?
YES                        NO

ANTI-RESONANCE (A-RES)
GAIN 1
GAIN 2

Profiling (PRFILE)
MULTI (Multistepping)
DYNSM (Dynamic Smoothing)
DSGAIN (Dynamic Smoothing Gain)

STOP RED TIMEOUT (I-STOP)

IDLE MODE REDUCTION (I-IDLE)
TIMEOUT
%RED

STALL DETECTION (STALL)
DISABLED
ENABLED

> SETUP > ADVNCE >  EDIT -↑↑↑↑  ADVANCED SETUP ↓↓↓↓ -
A-RES  DYN-SM  I-STOP

-↑↑↑↑  ADVANCED SETUP ↓↓↓↓ -
I-IDLE  STALL

> SETUP > ADVNCE > A-RESEDIT - - ANTI-RESONANCE - - 
GAIN1    GAIN2

- Anti-Res Gain #1    -
0

- Anti-Res Gain #2    -
0
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Configuring Profiling Parameters

MULTI  (Multi-Stepping™)
This option allows you to enable or disable Multi-Stepping™ feature. 

1. Press MULTI (F1).

2. Using arrow keys, select ENABLED or DISABLED.

3. Press ESC.

DYNSM (Dynamic Smoothing™)
This option allows you to enable of disable the Dynamic Smoothing™ feature.

1. Press DYNSM (F2).

2. Using arrow keys, select ENABLED or DISABLED.

3. Press ESC.

DSGAIN
This option allows you to enter a dynamic smoothing gain of between 20 and 2621. Setting gain to 
2621 effectively disables the Dynamic Smoothing™ feature. If Multi-Stepping™ been selected, the 
Dynamic Smoothing Gain will be fixed.

1. Press GAIN (F1).

2. Using numeric keys, enter a gain (0 to 2621).

3. Press ESC.

Configuring Stop Mode Current-Reduction Timeout (I-STOP)
This option allows you to set the Stop Mode current-reduction timeout in milliseconds. When the 
timeout period has elapsed, the command motor current will be reduced by up to 25%. Full current 
is restored on the next commanded step. The valid range for the timeout is from 0 ms to 19656 ms. 
Setting the timeout to 0 disables the Stop Mode feature and the display will read “Off”.

1. Using the numeric keys, enter the desired current-reduction timeout period.

2. Press ESC.

> SETUP > ADVNCE > DYN-SMEDIT - PROFILING -
MULTI   DYNSM  DSGAIN

 −−−  −−−  −−−  −−− Multi-Stepping  −−− −−− −−− −−−
↑   ↑   ↑   ↑        DISABLED       ↓↓↓↓

    Dynamic Smoothing 
↑   ↑   ↑   ↑        DISABLED       ↓↓↓↓

 −−−  −−−  −−−  −−− Dyn Sm Gain  −−− −−− −−− −−−
2621

> SETUP > ADVNCE > I-STOPEDIT - Stop Red Timeout -
Off
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Configuring Idle Mode Current Reduction Parameters
Use this option to set the Idle Mode current-reduction parameters (TIMEOUT and %RED). 

TIMEOUT sets the Idle Mode current reduction period in seconds. When the TIMEOUT period has 
elapsed, the commanded motor current will be reduced by the percentage defined in EDIT > SETUP 
> ADVNCE > I-IDLE > %RED. Full current is restored on the next commanded step. The valid 
range for the timeout is 0 to 3600 seconds. Setting the timeout to 0 disables the Idle Mode feature 
and the display will read “Off”.

%RED (percentage of reduction) sets the percentage of current reduction that occurs after the Idle 
Mode TIMEOUT has expired. The valid range for percentage of reduction is 0 to100%. The Idle 
Mode reduction percentage takes precedence over the Stop Mode 25% reduction if both modes have 
been enabled.

TIMEOUT

1. Press TMEOUT (F1).

2. Using the numeric and decimal keys, enter the desired 
current-reduction period (seconds).

3. Press ESC.

%REDUCTION (required only if TIMEOUT was configured)

1. Press  %RED (F2).

2. Using the numeric keys, enter the desired percentage of 
reduction (no decimal).

3. Press ESC.

Configuring Encoderless Stall-Detection (OLSD™)
This option allows you to enable or disable the OLSD™ feature. OLSD™ becomes active at 
velocities of 0.5 RPS and greater.

1. Using the up and down arrows, toggle to DISABLED or ENABLED OLSD™ .

2. Press ESC twice to return to the EDIT > SETUP menu.

> SETUP > ADVNCE > I-IDLEEDIT -  IDLE MODE REDUCT  -  
TMEOUT    %RED

-  Idle Mode Tmeout  -  
Off

-  Idle Mode %Redct  -  
0%

> SETUP > ADVNCE > STALLEDIT -    Stall   Detection   - 
↑          ↑          ↑          ↑          DISABLED           ↓↓↓↓
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I/O SETUP

This option allows you to configure up to (4) digital inputs and one (1) digital output.

Configuring Inputs
The input number (#1 - #4) is selected by using the right or left arrow key. The input function is 
selected by scrolling the list using the up or down arrow key. The INPUT menu consists of the inputs 
described in the table below. 

1. Press INPUT (F1).

2. Using the right or left arrow key, select the Input # (position) 
to be configured.

3. Using the up or down arrow key, select the desired input function.

4. Press ESC

> SETUP > I/OEDIT - - - -  I/O SETUP - - - - 
INPUT   OUTPUT  POLAR

Configurable Inputs Input Description
UNDEFINED The input position currently has no function

JOG + Jogs the motor in the positive direction
JOG - Jogs the motor in the negative direction

JOG SPEED Toggles between High and Low jog velocity
STOP Stops motion at the Stop Rate (internal move 

engine or external steps)
KILL Instantly stops motion (internal move engine or 

external steps)
EOT End-of-Travel (also used for Homing moves)

[RESERVED] Reserved for future use - acts as UNDEFINED
MOVE SELECT Acts as a bit in a binary move selection number
WARM BOOT Resets the drive

- - - ←↑   Input #1  ↓→ - - - 
UNDEFINED
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Configuring Outputs
The output function is selected by using the up or down arrow key. The OUTPUT menu consists of 
the outputs described in the table below. 

1. Press OUTPUT (F2).

2. Using the up or down arrow key, select the desired output 
function.

3. Press ESC

Configuring Input/Output Polarities
This option allows you to define the active polarity of the inputs and output. The polarity refers to 
the electrical sense of the node (i.e. an ACTIVE LOW input must be grounded to be asserted). 

The inputs and output are selected by using the left and right arrow keys. The polarity is selected by 
toggling between ACTIVE LOW and ACTIVE HIGH using the up and down arrow keys.

1. Press POLARITY (F3).

2. Using the right or left arrow key, select the desired input or 
output.

3. Using the up or down arrow key, toggle to the desired polarity.

4. Press ESC.

Configurable Inputs Input Description
UNDEFINED The output position has no function

BRAKE Activated on a fault
MOVING Activated when receiving steps or the internal move 

engine is active
[RESERVED] Reserved for future use - acts as UNDEFINED

STALLED Activated when the OLSD™ detects a stall

 - - - - ↑   Output #1  ↓ - - - - 
UNDEFINED

- - - ←↑   Input #1  ↓→ - - - 
ACTIVE LOW
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Move Menus - Using Stored Moves

This feature is only available of your Impulse is equipped with the optional Motion Node.

The MOVE menu allows you to edit the Stored-Move parameters (also see Edit > Stored Move menu 
in Application Developer).

Stored-Move Profiles
The PROFLE (profile) menu allows you to configure the seven (7) possible stored -move profiles 
executed by the internal move engine. The move number is selected by using the up or down arrow 
keys, and the move profile parameters are selected by using the left or right arrow keys. Units of 
acceleration, deceleration, velocity, and distance are defined in EDIT > SETUP > MECH > UNITS, 
and scaled by EDIT > SETUP > MECH > RATIO.

There are three (3) types of stored-move profiles:
INC - Incremental
ABS - Absolute
HOME - Home Routine

Incremental moves are indexed the commanded distance from the current position. 

Absolute moves are indexed to the commanded position. 

Home moves provide a built-in routine to automatically find an exact position to reference all moves 
from (i.e. to find the zero position after a system power cycle.) Home moves require the use of at 
least one EOT limit switch and one input configured as an EOT. Home moves do not require the use 
of a home switch. 

Home moves are executed as follows:

1. The drive begins moving in the direction specified by the sign of the velocity. Note: Negative 
velocities are only valid with Home moves. The move distance is always forced to be the sign 
opposite of the velocity sign.

2. The drive moves at the commanded velocity until an EOT switch is encountered and decels at 
the rate defined in EDIT > SETUP > COMAND > STPRTE.

3. The drive then switches direction and moves at 1/16 the commanded velocity to find the leading 
edge of the EOT switch.

4. The drive then performs a final incremental move from the edge of the EOT switch equal to the 
defined move distance.

> MOVE EDIT - - -  STORED MOVES - - - 
PROFLE  SCAN
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Configuring Stored-Move Profiles
There are five (5) stored move parameters to be configured: Acceleration, Deceleration, Velocity, 
Distance, and Move Type.

1. Press PROFLE (F1).

2. Using the up or down arrow key, select the Move # (1 - 7) to 
configured.

3. Using the right or left arrow key, select the move parameter 
to be configured.

Note: Step 4 applies to Accel, Decel, Velcty, and PosDis. 
Step 5 applies to MvType.

4. Using the numeric and decimal keys, enter the desired value 
of the parameter.

5. Using F1, F2, or F3, select the Move Type.

6. Press ESC.

Move Selection Input Scan Time
This option allows you to set the move selection input scan time in milliseconds. The scan time 
serves as a timeout for which the move selection inputs must be held in a stable state. If any move 
selection input changes state within the scan time, the timeout is reset (debounce). When the scan 
time has expired, the move corresponding to the binary number on the move selection inputs will be 
executed. The valid range of the scan time is 0 ms to 19660 ms.

Configuring Scan Time
1. Press SCAN (F2).

2. Using the numeric keys, enter the desired scan time in 
milliseconds.

3. Press ESC twice to return to the EDIT menu.

←↑  Move #1 Accel ↓→
0.0 RPS2

←↑   Move #1 Decel ↓→
0.0 RPS2

←↑   Move #1 Velcty ↓→
0.0 RPS2

←↑   Move #1 PosDis ↓→
0.0 RPS2

←↑   Move #1 MvType ↓→
[INC]         ABS       HOME

 

  Move  Sel  Scan  Time
0 ms
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UNIT#

This menu allows you to configure the unit number for use in RS232C daisy chains or RS485 buses.
The valid range for unit numbers is 1 - 99.

1. Using the numeric keys, enter the desired unit number for the drive.

Very Important! - Send the File to the Drive
When all setup parameters have been configured and the motor has been probed, use the COPY 
menu (COPY > FRM PAD) to send the project file to the drive.

> UNIT# EDIT - - -  Unit Number - - - 
1
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Chapter 6 - Hardware Reference

Impulse Specifications

Electrical Characteristics
Power Requirements 120 VAC ±10% single phase, 50/60 Hz, 500 VA max @ 4 A

Current Output Range 0.75  - 4.0 Amps

Motor Inductance Range 2 - 80 mH

Motor Resolution 25,600 Steps/Rev internal. 
Pre-scaled for the range 200 - 100,000

Motor Frame Size - NEMA 17 - 34

Step & Direction Inputs
Input Voltage *5 VDC (see note at bottom)

Input Current 5 - 15 mA

Setup Time (Direction) 250 ns

Max. Frequency (Step) 2 MHz

Shutdown Inputs
Single-Ended Mode Input Voltage (VDC) HIGH: 3 V min. to 5 V max.   LOW: 0 V min. to 1.5 V max.

Differential Mode (VDC between + and -) HIGH: 2 V min. to 5 V max.   LOW: -5 V min. to -2 V max. 

Input Current (any terminal @ 0 V to Gnd) -1 mA  to 15 mA

Digital Inputs
Input Voltage HIGH: 3 V min. to 24 V max.   LOW: 0 V min. to 1.5 V max.

Input Current @ 0 V -2.5 mA (inputs 1 & 2); -3.8 mA (inputs 3 & 4)

Digital Output
Current Sink (ON state, Max.) 100 mA

Output Voltage (ON state @ 100 mA  Max.) 0.4 V

Output Voltage (OFF state, Max.) 24 V

Environmental
Operating Ambient Temperature 0 to 50° C

Storage Temperature -40 to 80° C

Relative Humidity (Maximum) 95% non-condensing

Altitude above Sea Level 10,000 ft.  [3,048 m]

Thermal Characteristics
Cooling Internal

Heat Dissipation @ 4 A (typical) 32 W

Physical Characteristics
Dimensions (inches [mm])  H = 5.60 [142];  W = 1.78 [45];  D = 6.37 [162]

Weight 1.75 lbs [.794 kg]

*External current-limiting resistor required for 12V and 24V power supply connections. Use 560 Ohm, 1/4 W resistor for 12 
V connection. Use 1.3 KΩ resistor for 24 V connection.
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Remote Mounting Your Keypad

The keypad can easily be mounted and sealed to NEMA 4 specifications by using the included 
mounting gasket and 6-foot communication cable. Warning: Do not attach the gasket to the 
keypad.  Attach the gasket with the adhesive side toward the mounting enclosure. A pressure-seal 
is formed between the gasket and the keypad, while the adhesive maintains the seal between the 
enclosure and the gasket. 

A Keypad Mounting Template is included with every keypad, and a not to scale mounting 
dimensions drawing can be found on the next page for reference. Please pay particular attention to 
the CAUTION on the template.

Extending the Cable Length to Your Keypad
The keypad cable may be extended if necessary, but at longer distances your keypad may require a 
separate, regulated 5 VDC (500mA) power supply as shown in the illustration below. Consult IDC 
Applications Engineering if you have questions about this procedure.

Warning 
1)   When mounting the keypad on wall-type surfaces (as shown in the 
illustration below) be absolutely certain that you have accurately estimated 
the proper length of mounting screws. Your keypad may be damaged if a 
mounting screw is allowed to extend more than 0.20 inches into the keypad.

2)   When mounting the keypad to a metal surface, it is highly advisable that 
the keypad be insulated from the metal surface by using non-conductive 
fasteners (screws, washers, etc.).  

mounting surface

End View of Wall-Mounted Keypad with Cover Removed

Circuit Board

Mounting Screw

The circuit board may be 
damaged if any mount-
ing screw is allowed to 
extend more than 0.20’’ 
into the keypad.

keypad gasket

Keypad

+5V
GND

N/C GND RX TX +5V

+5V Regulated
Power Supply

KEYPAD

COM
PORT

+5V
RX
TX
COM
SHLD
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Keypad Mounting *Template

*CAUTION - this is scaled-down version of the keypad template. Use this drawing only for 
dimensions and locations of mounting holes. The actual template is included with your keypad and 
may also be found at:     http://www.idcmotion.com/support/index.html

KEYPAD MOUNTING TEMPLATE

E

M

B

CUT THESE HOLES FOR
6/32 CAPTIVE MOUNTING.

3/16" CLEARANCE HOLES (4)

CUT THESE HOLES FOR
M3.5 CAPTIVE MOUNTING.

CUT THESE HOLES FOR
BALL-HEAD REMOVABLE MOUNTING.5/32" CLEARANCE HOLES (3)

3/16" CLEARANCE HOLES (4)

CAUTION: Your Keypad will be damaged if mounting 
screws extend more than 0.2 inches into the keypad.
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Impulse I/O Schematics

Digital Inputs

Digital Output

+5V

1K1K

4.99K

TO COMMON

COM

AM26LS32

IN1_BUF

COM

IN1/IN2

+5V

Inputs 1, 2 

Inputs 3, 4 

external

external

 Impulse internal

 Impulse internal

+5V

1K

CMPD914

4.02k

COM

IN3/IN4

COM

LIMIT
SWITCH

external Impulse internal

+ANA

OUT

2.43K

MMBT2222ALT1

COM

TO PULLUP COMMON

OUT

10K

PULL-UP +5V,  +12V, or 24V

SOURCING
INPUT

RELAY
COIL

COM

OR
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Step, Direction, and Shutdown Inputs

Fault Output

2.2n 50V
COM

COM
237

4.99K 4.99K
+5V

4.99K

AM26LS32

DIFFERENTIAL 
DRIVER

STEP-
DIR-
SD-

STEP+
DIR+
SD+

Single-Ended
Installation

Application Notes:

1.When wiring TTL signals to other manufacturer’s indexers, the Step TTL command signals from 
the controller should be wired to Step +, the Direction signal to Dir +, and  the Shutdown signal 
to SD + (Step -, Dir -, and SD - should not be connected). Remember to connect commons.

2.Activating the Shutdown input (logic low) disables the drive amplifier and de-energizes the motor. 
When this input is off (logic high) the drive is enabled and the motor is energized.

external

 Impulse internal

 Impulse internal

external

Differential
Installation

2.2n 50V

237
4.99K

4.99K4.99K
COM

COM

COM

+5V
STEP-
DIR-
SD-

STEP+, DIR+, SD+

SINKING
OUTPUT

COM

237
+5V

FAULT

FAULT+

FAULT-

4N35

NC

FAULT+ FAULT-

FAULT+ FAULT-

EQUIVALENT
CIRCUITS

external Impulse internal

Drive Faulted

No Fault Present
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Using IDC Position Sensors as EOT Limit Switches with the Impulse
Four IDC position sensors may be used as EOT limit switches with the Impulse. Connection 
information for all four sensors is provided below. 

+5V

COM

COM

N.C. Reed Switch

RPS-2
Only

 INPUT

external Impulse internal

external Impulse internal

external Impulse internal

• The PSR-2 position sensor is a nor-
mally closed Reed Switch and must be 
connected to two (2) separate inputs, as 
shown here. This leaves two (2) inputs 
for move selects, which allows for the 
selection of three (3) stored moves.

• The PSR-2 position sensor contains a 
series diode and cannot be used in 
series, as is the RPS-2 sensor shown 
below.

• Note: If you need to configure more 
than 3 stored moves, the position sen-
sors below only require one input for 
connection.

+5V

COM

COM

RPS-1
or

PSR-1

N.O. Reed Switch

INPUT

• The RPS-2 position sensor is a nor-
mally closed Reed Switch and must be 
connected in series as shown here.

• The RPS-1 or PSR-1 position sensors 
are normally open Reed Switches and 
must be connected in parallel as shown 
here.

+5V

COM

COM

PSR-2
Only

N.C. Reed Switch

INPUT

+5V

INPUT

INPUT

INPUT

PSR-2

RPS-2

RPS-1 
PSR-1
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Optional Accessories for Your Impulse

Impulse I/O Accessories
Accessory (P/N & Description)

DB25BO

Screw Terminal Breakout Board

See page next page for connection information.

SS-IO
SS-IO-6

25-pin D-Shell I/O cable that connects Impulse 
to other devices or PLC 

SS-IO is 2 ft.
SS-IO-6 is 6 ft.

See the next page for wire color codes

SS-RS232

Cable for connecting Impulse  to PC (9-pin 
Comm. Port)

PCS-5004

PC-Keypad Cable for copying programs 
between keypad and PC

Dimensions:
2.0L x 1.0W x 0.8D
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DB25BO Screw Terminal Breakout Board
When connected to the Impulse, the DB25BO terminals will match the pinouts of the 25-pin 
connector as shown below.

SS-IO/SS-IO-6 Cables

25-pin Connector

DB25BO

on Impulse Drive

DB25BO
Screw

Terminal
Breakout

Board

IDC Cable P/N: SS-IO/SS-IO-6
Pin Impulse Signal Wire Color Pin Impulse Signal Wire Color Pin Impulse Signal Wire Color

1 STEP + Brown 10 COM Gray 19 COM Black/White
2 STEP - Red 11 COM White 20 Reserved Red/Black
3 DIR + Orange 12 Reserved Black 21 Reserved Orange/Black
4 DIR - Pink 13 Reserved Brown/White 22 COM Yellow/Black
5 SD + Yellow 14 INPUT 1 Red/White 23 Output 1 Green/Black
6 SD - Green 15 INPUT 2 Orange/White 24 Reserved Gray/Black
7 FAULT + Light Green 16 INPUT 3 Green/White 25 Reserved Pink/Black
8 FAULT - Blue 17 INPUT 4 Blue/White Note: Cable SHIELD is internally connected to 

the DB25 metal housing.9 Drain Violet 18 COM Violet/White
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Impulse-Applicable IDC Motors

S12 Hybrid Step Motor

Electrical Specs. S12T
Continuous Stall Torque                                  oz-in [N-m] 35 [0.25]
Recommended Current/Phase                                Amps 1.0
Winding Resistance @ Ambient                              Ohms 5.52
Inductance                                                                  mH 8.8
Max. Winding Temperature                                    °F [°C] 212 [100] 

Mechanical Specs. S12T
Rotor Inertia                                               oz-in-s2 [kg-m2] 5.1x10-4

Axial Shaft Load                                                     lbs [N] 10 [45]
Radial Shaft Load @ 0.5 inches                             lbs [N] 5 [22]
Motor Weight                                                         lbs [kg] 0.66 [0.3]
Step Angle (full step)                                           degrees 1.8

Note:

• IDC step motors require a 
torque safety margin of  at 
least 30%.

(BOTH ENDS)

IDC Motor Wiring Series
YELLOW

WHT/YEL

WHT/RED
RED

SHIELD

BLACK

WHT/BLK

WHT/ORG
ORANGE
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S21, S22, S23 Hybrid Step Motor Specifications

Electrical Specs. S21T S21V S22T S22V S23T S23V
Continuous Stall Torque               oz-in [N-m] 65 [0.46] 100 [0.71] 125 [0.88]
Recommended Current/Phase            Amps 1.05 2.1 1.5 3.0 1.75 3.5
Winding Resistance @ Ambient          Ohms 5.4 1.35 4.8 1.2 4.4 1.1
Inductance                                                 mH 18 4.5 18 4.5 18 4.5
Max. Winding Temperature               °F [°C] 212 [100] 212 [100] 212 [100]

Mechanical Specs. S21T S21V S22T S22V S23T S23V

Rotor Inertia                           oz-in-s2 [kg-m2] 1.66x10-3[1.17x10-5] 3.31x10-3[2.34x10-5] 4.97x10-3[3.51x10-5]
Axial Shaft Load                                 lbs [N] 25 [111] 25 [111] 25 [111]
Radial Shaft Load @ 0.5 inches         lbs [N] 5.6 [25] 5.6 [25] 5.6 [25]
Motor Weight                                      lbs [kg] 1.6 [0.73] 2.4 [1.1] 3.2 [1.5]
Step Angle (full step)                        degrees 1.8 1.8 1.8

Notes:
• T = Series   V = Parallel

• Parallel (V) wiring: 50% duty cycle 
max above 5 rps (300 rpm).

• IDC step motors require a torque 
safety margin of at least 30%.

.002 A

A.003

.002 A

IDC Motor Wiring

Series
YELLOW

WHT/YEL

WHT/RED
RED

SHIELD

BLACK

WHT/BLK

WHT/ORG
ORANGE

Parallel

YELLOW

WHT/RED
RED

WHT/YEL

SHIELD

BLACK

WHT/ORG
ORANGE

WHT/BLK
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S32, S33 Hybrid Step Motor Specifications 

1/2-14NPS
ON A 3.875 B.C.

0.23/0.21 THRU (4)

.001 A

A.003

Electrical Specs. S32T S33T
Continuous Stall Torque          oz-in [N-m] 300 [7.1] 400 [5.3]
Recommended Current/Phase         Amps 2.8 3.5
Winding Resistance @ Ambient      Ohms 1.03 .96
Inductance                                          mH 10 10
Max. Winding Temperature           °F [°C] 212 [100] 212 [100]

Mechanical Specs. S32T S33T

Rotor Inertia                      oz-in-s2 [kg-m2] 0.017 [3.51x10-5] 0.0265 [3.51x10-5]
Axial Shaft Load                                 lbs [N] 50 [222] 50 [222]

Radial Shaft Load @ 0.5 inches    lbs [N] 14.5 [64.4] 14.5 [64.4]
Motor Weight                                     lbs [kg] 5.1 [2.3] 8.3 [3.8]
Step Angle (full step)                      degrees 1.8 1.8

Notes:
• T = Series   V = Parallel

• Parallel (V) wiring: 50% 
duty cycle max above 5 
rps (300 rpm).

• IDC step motors require a 
torque safety margin of at 
least 30%.

Wire Color on Quick 
Disconnect Cables

Drive
Connection

Red w/ Black B-
Red w/ White B+

Green *GND
Red w/ Yellow A-

Red A+
*Gray-colored Quick Disconnect Cables 
are shielded - connect shield to GND.

IDC Quick
Disconnect
Cable
P/N QF3-12

IDC Motor Wiring

Series
YELLOW

WHT/YEL

WHT/RED
RED

SHIELD

BLACK

WHT/BLK

WHT/ORG
ORANGE

Parallel

YELLOW

WHT/RED
RED

WHT/YEL

SHIELD

BLACK

WHT/ORG
ORANGE

WHT/BLK
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P21, 22 Hybrid Step Motor Specifications

90

.021.11

2.22

EQ SP AS SHOWN
2.625.02

ON A 
.010

 BC
A B

3X

.022.22

1.11 .02

45

.2054X .010 THRU
A

C

.03

.02.70

.81

 BCON A 
P22: 3.090 MAX

1.812
A.010 C

30CABLE X 144.0 LONG MIN
WITH FOIL SHIELD AND DRAIN

8X #24 AWG CONDUCTOR

C
E

.75

.06

.20

.02

.02

2X 4-40 UNC-2B 
EQ SP AS SHOWN

.04  .10

180

.31 .02

APPROXIMATE SIZE .23 DIA

.005.219

CA.001
.004 A

.2495

.2500

C.002 A

1.500 .002

B

.001 A C
.004 A

.2500

.2495

P21: 2.205 MAX

Note: Specs. apply to parallel (120 VAC) connections.

Electrical Specs. P21V P22V
Continuous Stall Torque                            oz-in [N-m] 100 200
Recommended Current/Phase                           Amps 1.3 2.0
Winding Resistance @ Ambient                        Ohms 4.7 3.7
Inductance                                                             mH 20 16
Max. Winding Temperature                             °F [°C] 248 [120]

Mechanical Specs. P21V P22V

Rotor Inertia                                         oz-in-s2 [kg-m2] 0.0035 [2.48x10-5] 0.0061 [4.32x10-5]
Axial Shaft Load                                              lbs [kg] 10 [44]
Radial Shaft Load @ 0.75 inches [19mm]       lbs [kg] 15 [66]
Motor Weight                                                   lbs [kg] 1.9 [0.86] 2.7 [1.23]
Step Angle (full step)                                      degrees 1.8

Note:
• IDC step motors 

require a torque 
safety margin of at 
least 30%.

IDC Motor Wiring Parallel
YELLOW

WHT/RED
RED

WHT/YEL

SHIELD

BLACK

WHT/ORG
ORANGE

WHT/BLK
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P/K 31, 32, 33Step Motor Specifications 

EQ and EM Encoder Cables Quick Disconnect Motor Cable Motor Dimensions
Signal *Pin Color Wire Color Signal Motor D K T X LMAX

A+ B Red Red w/ Black B- P31 .5000 .1250 .555  (3.70) 4.44
A- C Pink/Purple Red w/ White B+ P32 .5000 .1250 .555  (5.22) 5.96
B+ N Green Green *GND P33 .6250 .1875 .705  (6.74) 7.48
B- P Blue Red w/ Yellow A-
Z+ M Yellow Red A+
Z- U Orange  *Connect shield of gray QF3-12 

cable to GND.+5V K White
COM T Black
Shld --- ---
*EQ Cable only. Brown-NC

Electrical Specs. P31V P32V P33V
Continuous Stall Torque                         oz-in [N-m] 450 [3.2] 920 [6.5] 1260 [8.9]
Recommended Current/Phase                      Amps 2.9 3.3 4.0
Inductance                                                            mH 14 30 25
Max. Winding Temperature                           °F [°C] 212 [100] 212 [100] 212 [100]

Mechanical Specs. P31V P32V P33V
Rotor Inertia                                                oz-in-sec .0202 .038 .0567
Axial Shaft Load                                              lbs [N] 305 [1350] 305 [1350] 305 [1350]
Radial Shaft Load @ 0.5 inches                   lbs [N] 665 [285] 665 [285] 110 [489]
Motor Weight                                                  lbs [kg] 5 8.4 11.9
Step Angle (full step)                                   degrees 1.8 1.8 1.8

IDC Quick Disconnect Cable
P/N QF4-12    (18AWG)

EQ 
Encoder 

Cable

IDC Motor Wiring

Series
YELLOW

WHT/YEL

WHT/RED
RED

SHIELD

BLACK

WHT/BLK

WHT/ORG
ORANGE

Parallel

YELLOW

WHT/RED
RED

WHT/YEL

SHIELD

BLACK

WHT/ORG
ORANGE

WHT/BLK
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Chapter 7 - Troubleshooting the Impulse

This chapter covers common faults, their possible causes and remedies. Also include in this chapter 
are Impulse Limits Tables for a variety of operational parameters, e.g. the Acceleration/
Deceleration/Velocity Limits Table.

The Impulse drive detects and resolves fault conditions. Faults are signaled by either a steady red or 
flashing red LED on the front panel. A solid green LED indicates normal operation. Most faults are 
cleared by either 1) cycling power, 2) sending a RESET command via the serial port or configurable 
logic input, or 3) probing the motor if the LED is steady red.

Read the CAUTION below before troubleshooting your Impulse.

Troubleshooting Table
This table provides possible remedies to other problems you might have with your application.

Symptom Possible Causes Possible Remedies

Motor moves the wrong dis-
tance

Wrong gear ratio. Check distance units.

Motor stalled or slipping. Check motor current anti-resonance 
settings.

Control and drive resolutions don’t 
match.

Check Speed Torque requirements 
of move.  Decrease acceleration.

Motor stalls (1 LED flash) Acceleration and/or velocity are too 
high.

Reduce acceleration and/or velocity.

Motor configured incorrectly. Check motor current, inductance, 
anti-resonance settings.

Motor moves the wrong direc-
tion

The motor phases are mis-wired. Check per manual, or swap A+ with 
A-.

The system’s direction is opposite 
the configured drive direction.

Change the control’s direction pa-
rameter.

The controller does not re-
spond to keypad input.

The keypad has been disabled. Check the DIP switch settings on the 
back of the keypad.

Incorrect unit address. Change the unit address.

CAUTION!

• Always use caution when working with mechanical systems. Gears and screw-driven 
cylinders are capable of exerting tremendous force against an obstruction.

• Always ensure that power to your system is OFF before performing any mainte-
nance activity, or making any connections or adjustments.

• Do not insert objects into the Impulse drive. High voltages could cause personal 
injury, and equipment could be damaged beyond repair.

• Do not open the Impulse drive. The factory warranty will be voided if the drive is 
opened.
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The keypad is blank, but the 
backlight is on.

You have an older keypad that re-
quires new firmware.  The Impulse 
requires a keypad with Version 3.00 
firmware or higher.

Call IDC for a free firmware upgrade 
to your keypad.

The keypad is blank and the 
backlight is off.

The keypad is not receiving a good 
+5VDC signal.  

Check wiring, verify that the +5VDC 
is between 4.8 and 5.2V.

It is difficult to read the display The contrast potentiometer needs 
adjustment

Adjust the contrast with the pot on 
the back of the keypad.

Can’t Communicate over 
RS232, but keypad works.

If the keypad works, the Impulse 
RS232 port is working.  Something 
else is configured wrong (i.e. wiring, 
configuration, address).

Refer to Chapter 5, RS232 Trouble-
shooting, for help on this subject.

Can’t Communicate over 
RS232, and keypad does 
NOT work.

Impulse is configured as RS485. Check the label to make sure you 
don’t have an RS485 version. Either 
connect to RS485 or call IDC (or your 
distributor) to exchange units.

The keypad is disabled. Enable keypad through DIP switch 
on back of keypad and try again.  

The serial port is not working. Call IDC (or your distributor) for ap-
plication assistance.

Steady Red LED Motor not probed. If using Application Developer, use 
the Project Wizard or select Run > 
Probe Motor from the main menu. If 
using a keypad, select RUN > 
PROBE.

1 LED Flash (Stall) Motor stalled. Motor may not produce enough 
torque for the application.

“Nuisance fault” - using a non-IDC 
motor.

Call IDC for assistance.

2 LED flashes
(Undervoltage Fault)

Indicates that the high-voltage pow-
er supply has fallen below 110 VDC 
for more than 3 seconds. This pre-
vents the drive from trying to operate 
a motor with insufficient power to 
meet speed-torque performance ob-
jectives.

Verify power supply voltage integrity.

3 LED flashes
(Overvoltage Fault)

Bus voltage is too high. This is usu-
ally caused by a regeneration event 
that overwhelms the internal power-
dump circuit.  It can also be caused 
by high line voltage or voltage 
spikes.

Eliminate the regen event by reduc-
ing the load or make the move less 
aggressively by reducing the com-
manded acceleration or velocity. 
Check your AC line voltage to verify 
it is within the Impulse’s limits.

4 LED flashes
(Over Current Fault)

The motor is mis-wired or internally 
shorted.  The Impulse is protected 
against such shorts, but you will 
need to correct the problem to pre-
vent the fault.

With power off recheck connections.  
Check Impulse current setting to 
make sure you did not accidentally 
damage a winding by using a higher 
current than the motor is rated for.  
Check to see the motor phases are 
not shorted to one another or to the 
case of the motor.  The resistance in 
each phase should be about the 
same; only a few ohms.  If the phas-
es are open or have large resistanc-
es, the motor is probably damaged 
and should be replaced.

5 LED flashes
(Interlock Fault)

Motor connector does not contain 
an interlock jumper, motor has been 
disconnected, or interlock jumper is 
loose.

Ensure interlock jumper is securely 
wired into motor connector. Ensure 
motor connector is securely plugged 
into the motor jack on the drive.

Symptom Possible Causes Possible Remedies
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Limits Tables
Velocity Limits at ALL RESOLUTIONS are:
Min = 0.00002 RPS
Max = 100 RPS

Acceleration and Deceleration Limits are the following:

6 LED flashes
(Over Temperature Fault)

Internal Fan or Heatsink Tunnel is 
clogged or restricted (internal temp. 
has exceeded 68° C (154° F).

Remove obstruction (clean by blow-
ing shop air through the tunnel.

Ambient air in cabinet is too hot. The Impulse can produce 20 Watts 
of heat. If multiple units are installed 
next to each other, the cabinet must 
be adequately ventilated to remove 
heat.

The cooling fan is not turning. Cooling fan is inoperable. Return unit 
to factory for repair.

7 LED Flashes 
(EEPROM Checksum Fault)

At power-up the drive tests the in-
tegrity of its non-volatile memory by 
computing a checksum. This fault 
indicates an abnormal or defective 
condition in the drive. 

An error occured during download 
or EEPROM write.

The fault can be cleared by issuing a 
default configuration from Applica-
tion Developer and then reconfigur-
ing the drive for the target motor. If 
the fault recurs, the drive is definitely 
defective. The user should not be 
able to cause this fault inadvertently 
through any combination of com-
mands or actions.

Symptom Possible Causes Possible Remedies

Step
Resolution

Accel/ Decel Limits

Min (RPS2) Max (RPS2) 

200 0.001 1000000

400 0.001 500000

1000 0.001 200000

2000 0.001 100000

5000 0.001 40000

10000 0.001 20000

18000 0.001 11110

25000 0.001 8000

25400 0.001 7874

25600 0.001 7812

36000 0.001 5555

50000 0.001 4000

50800 0.001 3937

100000 0.001 2000
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Chapter 8 - Product Support

Factory Authorized Distributors
IDC has more than 45 factory-trained and authorized automation technology distributors located 
throughout North America, Western Europe, and the Pacific Rim. Each has been selected for their 
technical expertise, their local market knowledge, and exemplary business practices. They are ready 
to assist you in applying Industrial Devices’ systems, as well as other complementary equipment. 
Contact us at (800) 747-0064 or (707) 789-1000 (from outside the U.S.) for the name of the 
distributor in your area. 

Regional Offices
IDC Distributors are supported by local, direct IDC Regional Managers. IDC Regional Managers 
are available to assist with unusually demanding applications, present on site customer seminars, 
determine custom product needs, or respond to high volume requirements.

Toll Free Technical Support
Industrial Devices employs a large staff of mechanical and electrical engineers, whose full time 
responsibility is to help you select the proper system, install it correctly, and get it up and operating 
to your satisfaction. The Applications Engineering department is open from 6am to 5pm Pacific 
Time, Monday through Friday. The toll free number is (800) 747-0064. Outside of the United States 
call (707) 789-1000. The technical support fax number is (707) 789-0175.  Email should be directed 
to: support@idcmotion.com.

CAD Library
IDC actuator, motor, and gear-motor CAD drawings (in .dxf format) are available to save you 
valuable design time and prevent transcription errors. Low volume requests are complimentary. 
Check the web site for CAD drawings that may be downloaded.

Web Site
Check us out at www.idcmotion.com for information on our products and support.
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Warranty & Repairs

Industrial Devices Corporation (IDC) warrants this product to be free of defects in material and 
workmanship for a period of two (2) years from the date of shipment to the end user. Products that 
have been improperly used or damaged, in the opinion of IDC, are not subject to the terms of this 
warranty.

IDC maintains a repair facility at its factory in Petaluma, California for products manufactured by 
IDC.  Prior approval by IDC is required before returning any product for any reason. All returned 
packages must be accompanied by an RMA# (Return Material Authorization number). 

To obtain return authorization, contact your local IDC distributor or IDC. Please note the following 
procedure:

1. Obtain the model and serial number of the defective unit.

2. Prepare a purchase order for possible repair cost, in the event that the unit is not warranted.

3. Contact your IDC distributor or IDC (1-800-747-0064) for an RMA#.

4. Provide information describing the nature of the failure.  The better the information, the faster 
we’ll have your problem resolved.

5. Ship unit prepaid to the address below (be sure to include your RMA # on the shipping label):

Attn: Repair Department
RMA# _ _-_ _ _
Industrial Devices Corporation, LLC
3925 Cypress Drive
Petaluma, CA 94954
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Appendix A: Recommended Wiring Practices for IDC Controls

When configuring your Impulse please follow the wiring practices listed below:

• Earth ground your machine at one point using a star configuration (shown at right).
Multiple earth grounds can cause a ground loop (see Preventing Ground Loop below). 

• Avoid long cable runs. The longer the cables, the lower the signal-to-noise ratio in your 
application.

• Use shielded motor and encoder cables along the entire cable run.
• Separate the signal wires (I/O, encoder, etc.) from the motor wires, AC power wires, and other 

sources of noise in your application.
• Avoid extending cables in the field via junction boxes, terminal strips, or Molex connectors. 

These types of connectors are typically unshielded (as is wire going into and out of the connec-
tor) and are places where noise may be injected into the system.

• Connect cable shields at the control end of your machine. Connect the motor cable shield to 
GND, and connect the encoder shield to COM on the control.

• Do not connect the logic common (COM) of the IDC control to earth ground on your machine 
or to the GND terminal on the control/drive. Separating earth ground from logic common min-
imizes the potential for ground loops.

• Use shielded cables inside your panel (if control is panel or cabinet-mounted) for I/O and 
encoder wiring.

• Use differential, line-driven encoders with shielded, twisted-pair encoder cables. Single-ended 
TTL encoders are susceptible to noise and should be avoided.

• For optimum noise immunity use IDC motors and encoders with IDC controls.

Additional Wiring Practices When Connecting an IDC Control to a PLC
• Connect the PLC logic common and the IDC COM terminals together.
• Disconnect the jumper between Pull-Up (or P-Up) and +12 VDC on the IDC control. Connect 

the positive terminal of the PLC power supply to Pull-Up (or P-Up), and connect the Power 
Supply common to the COM terminal on the IDC control, or to the PLC logic common (these 
should both be at the same potential).

• IDC inputs are Sourcing, so PLC outputs connected to IDC inputs should be Sinking.
• IDC outputs are Sinking, so PLC inputs connected to IDC ouputs should be Sourcing.

Possible Ground Loop

Insert an ungrounded adapter to 
break the ground loop. Do Not

Connect
Pig-tail 
Wire

Preventing a Ground Loop
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Appendix B - Impulse Advanced Programming

The purpose of this section is to provide the information necessary for the user to communicate with 
an Impulse drive over a serial connection without using IDC Application Developer.  Since the 
Impulse communications protocol is not ASCII character based, the terminal window in IDC 
Application Developer and terminal emulation programs such as Windows™ HyperTerminal are not 
compatible for use with the Impulse drive.  Therefore, the topics covered here are considered 
advanced and require the user to understand how to directly interface with a PLC or PC serial port 
through programming (i.e. C or C++) or a MMI / soft PLC software package.

Communications Protocol
Transmission Frame

The Impulse drive does not use the ASCII character set for encoding and parsing serial data but 
rather transmits actual numeric data in the form of bytes.  This convention allows for faster and more 
efficient serial communications by reducing the number of bytes required for data transmission and 
eliminating the need to convert ASCII character strings into raw data.  Therefore, data references 
from this point forward represent actual numbers not ASCII text.  For example, a ‘1’ means a value 
of 1 not the ASCII text character ‘1’.

The core of the Impulse communication protocol consists of a series of bytes called the transmission 
frame.  The structure of the transmission frame is as follows:

Unit Address
This byte specifies the address of the unit for which this transmission frame is intended.  The valid 
range for the unit address is 1 to 255 and the factory default address is 1.

Parameter Index
This byte specifies the index of the parameter to be written to or read from.  Parameter reads and 
writes are determined by the state of the most significant bit of the parameter index byte.  If the bit 
is zero, the transmission frame is designated as a write.  If the bit is one, the transmission frame is 
designated as a read.  The valid range for the parameter index is 1 to 127 for writes and 129 to 255 
for reads.  For example, if BYTE #2 in the transmission frame equals 5, this would define a write to 
parameter index #5 however, if BYTE #2 equals 133, this would define a read from parameter index 
#5.  A parameter index can be converted to a read by simply taking the index and adding 128, thus 
setting the most significant bit to 1.

Data Bytes
These bytes specify the data to be written to or read from the parameter index.  All parameter index 
data is in word format (2 bytes) with the least significant byte preceding the most significant byte.  
Therefore, the smallest number of data bytes is 2.

Checksum Bytes
These bytes contain the unsigned sum of the Unit Address, Parameter Index and Data Bytes.  These 
bytes are using for transmission integrity verification.

BYTE #1 BYTE#2 BYTE#3…#n BYTE #n+1 BYTE #n+2

Unit
Address

Parameter
Index

Data
Bytes

Checksum
Lower Byte

Checksum
Upper Byte
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Byte Receive Time Out
Since there is no end of transmission frame deliminator, the Impulse assumes if no bytes are received 
for 60 ms, the transmission is complete.  The receive time out is reset on every byte received 
therefore, the host system must insure that the latency between transmitted bytes is less than 60 ms.

Receive Buffer Overrun
The Impulse receive buffer is 25 bytes however, there are no valid transmission frames of this length.

Reading and Writing Parameter Data

The Impulse does not support continuous data streaming due to its condensed receive buffer.  
Therefore, the host system must wait for a drive response before sending additional read or write 
transmission frames.

Read Queries
The following example illustrates a read request of parameter index #113 (Commanded Position) 
from unit #2.  Bytes are shown in hexadecimal format.

After sending the read request, the host system would need to wait for the drive to respond before 
sending another read query or write request.  The drive responds to a read with unit address, 
parameter index, data and checksum.  Assuming the commanded position is 25000 steps, the 
response would be as follows:

Since Commanded Position is a 32-bit value, the data field in the transmission frame is 4 bytes (2 
words).

02   F1   F3   00

Checksum Upper Byte
Checksum Lower Byte (Address + Index)
Read Parameter Index (113 + 128)
Unit Address #2

Checksum Upper Byte
Checksum Lower Byte (Address + Index)
Cmd Position Upper Byte, Upper Word
Cmd Position Lower Byte, Upper Word
Cmd Position Upper Byte, Lower Word
Cmd Position Lower Byte, Lower Word
Parameter Index 113
Unit Address #2

02  71  A8  61  00  00  7C  01
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Write Requests
The following example illustrates a write request of zero to parameter index #113 (Commanded 
Position) to unit #1.  Bytes are shown in hexadecimal format.

After sending the write request, the host system would need to wait for the drive to respond before 
sending another read query or write request.  The drive responds to a write with a standard frame of 
unit address, a parameter index of zero, data and checksum.  A successful write response is as 
follows:

A non-zero transmission status indicates an error has occurred.  Interpreting the transmission status 
is covered in the next topic.

Interpreting the Transmission Status Response
Whenever an error occurs during a transmission received by the drive, the drive reports the error in 
the Transmission Status Response.  Error response are defined as follows:

0 No Error
4 Receive Checksum Error
8 Invalid Parameter Data Field Length

Checksum Upper Byte
Checksum Lower Byte (Address + Index + Data)
Cmd Position Upper Byte, Upper Word
Cmd Position Lower Byte, Upper Word
Cmd Position Upper Byte, Lower Word
Cmd Position Lower Byte, Lower Word
Parameter Index 113
Unit Address #1

01  71  00  00  00  00  72  00

Checksum Upper Byte
Checksum Lower Byte (Address + Index + Data)
Transmission Status Upper Byte
Transmission Status Lower Byte
Parameter Index 113
Unit Address #1

01  00  00  00  01  00
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User Accessible Parameters

Serial Jog Velocity (RAM Only)
Description:  Velocity value for the serial jog velocity in RPS.

Parameter Parameter Description Default Value

SerJogV_H Serial Jog Velocity Upper Word 0 (0h)

SerJogV_L Serial Jog Velocity Lower Word 0 (0h)

Parameter Formula

SerJogV_H SerJogV_H = INT[(VelocityRPS)(50x10-6)(StepResolution)(65535)]

SerJogV_L SerJogV_L = INT[FRAC[(VelocityRPS)(50x10-6)(StepResolution)(65535)]]

Index Parameter Description

31 SerJogV_H; SerJogV_L

Transmission Frame
Unit Address 31 SerJogV_H

LSB
SerJogV_H

MSB
SerJogV_L

LSB
SerJogV_L

MSB
CkSum

LSB
CkSum
MSB

Formulas

Index

Parameters
& Defaults
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Jog Acceleration Rate

Description:  Determines the acceleration rate value in RPS2.

Parameter Parameter Description Default Value

JogAcel_H  Jog Acceleration Rate Upper Word 81 (51h)

JogAcel_L  Jog Acceleration Rate Lower Word 60210 (EB32h)

Parameter Formula

JogAcel_H JogAcel_H = INT[(AccelRPS2)(50x10-6)2(StepResolution)(65535)]

JogAcel_L JogAcel_L = INT[FRAC[(AccelRPS2)(50x10-6)2(StepResolution)(65535)](65535)]

Index Parameter Description

34 JogAcel_H; JogAcel_L

Transmission Frame
Unit Address 34 JogAcel_H

LSB
JogAcel_H

MSB
JogAcel_L

LSB
JogAcel_L

MSB
CkSum

LSB
CkSum

MSB

Formulas

Index

Parameters
& Defaults
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Stored Move Profiles #1 - #7 for Acceleration, Velocity, Deceleration
Description: Determines Move Profiles #1 through #7 (acceleration, velocity and deceleration) for 
the internal move engine as selected by the move selection inputs or over RS232/485.

Parameter Parameter Description Default Value

StMvAlncH Acceleration Upper Word 40 (28h)

StMvAlncL Acceleration Lower Word 62873 (F599h)

StMvVlncH Velocity Upper Word 0 (0h)

StMvVlncL Velocity Lower Word 0 (0h)

StMvDlncH Deceleration Upper Word 40 (28h)

StMvDlncL Deceleration Lower Word 62873 (F599h)

Parameter Formula

StMvAlncL StMvAlncH = INT[(AccelRPS2)(50x10-6)2(StepResolution)(65535)]

StMvAlncL StMvAlncL = INT[FRAC[(AccelRPS2)(50x10-6)2(StepResolution)(65535)](65535)]

StMvVlncH StMvVlncH = INT[(VelocityRPS)(50x10-6)(StepResolution)]

StMvVlncL StMvVlncL = INT[FRAC[(VelocityRPS)(50x10-6)(StepResolution)](65535)]

StMvDlncH StMvDlncH = INT[(DecelRPS2)(50x10-6)2(StepResolution)(65535)]

StMvDlncL StMvDlncL = INT[FRAC[(DecelRPS2)(50x10-6)2(StepResolution)(65535)](65535)]

Index (XX) Parameter Description

61 Stored Move Profile #1

62 Stored Move Profile #2

63 Stored Move Profile #3

64 Stored Move Profile #4

65 Stored Move Profile #5

66 Stored Move Profile #6

67 Stored Move Profile #7

Transmission Frame
Unit Address XX (see Mem. 

Map Index)
StMvAlncH

LSB
StMvAlncH

MSB
StMvAlncL

LSB
StMvAlncL

MSB
SDtMvVlncH

LSB
SDtMvVlncH

MSB

StMvVlncL
LSB

StMvVlncL
MSB

StMvDlncH
LSB

StMvDlncH
MSB

StMvDlncL
LSB

StMvDlncL
MSB

CkSum
LSB

CkSum
MSB

Formulas

Index

Parameters
& Defaults&
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Stored Move Profile #1 - #7 for Move Type, Move Distance, Deceleration Distance
Description: Determines Move Profiles #1 through #7 (move type, move acceleration and 
deceleration distances) for the internal move engine as selected by the move selection inputs or 
over RS232/485.

Parameter Parameter Description Default Value
StMvMT Move Type/Acceleration Ratio 0 (0h)

StMvMDH Move Distance Upper Word (Steps) 0 (0h)

StMvMDL Move Distance Lower Word (Steps) 0 (0h)

StMvADH Acceleration Distance Upper Word 0 (0h)

StMvADL Acceleration Distance Lower Word 0 (0h)

StMvDDH Deceleration Distance Upper Word 0 (0h)

StMvDDL Deceleration Distance Lower Word 0 (0h)

Parameter Formula
Incremental Moves StMvMT = 0

Homing Moves StMvMT = -1

Absolute Moves  

All Moves StMvMDx = Move Distance Steps

( ) ( ) 1+











+

























+
= 0.532767

RPS DecelRPS Accel
RPS Decel INT StMvMT

22

2
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( ) ( )Resolution Step

RPS onAccelerati Move(2)
RPS Velocity Move  StMvADx 2 











=

2

( )
( ) ( )Resolution Step

RPS onDecelerati Move(2)
RPS Velocity Move  StMvDDx 2 











=
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Index (XX) Parameter Description
68 Stored Move Profile #1

69 Stored Move Profile #2

70 Stored Move Profile #3

71 Stored Move Profile #4

72 Stored Move Profile #5

73 Stored Move Profile #6

74 Stored Move Profile #7

Transmission Frame
Unit Address XX (see Mem. 

Map Index)
StMvMT

LSB
StMvMT

MSB
StMvDH

LSB
StMvDH

MSB
SDtMvDL

LSB
SDtMvDL

MSB

StMvADH
LSB

StMvADH
MSB

StMvADL
LSB

StMvADL
MSB

StMvDDH
LSB

StMvDDH
MSB

StMvDDL
LSB

StMvDDL
MSB

CkSum
LSB

CkSum
MSB

Formulas

Index

Parameters
& Defaults&
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Serial Port Stored Move Selection (RAM Only)
Description:  Selects stored moves 1-7.

Parameter Parameter Description Default Value

SerMvSel Stored Move Selection 0 (0h)

Parameter Formula

SerMvSel SerMvSel = Stored Move Number

Index Parameter Description

75 SerMvSel

Transmission Frame
Unit Address 75 SerMvSel

LSB
SerMvSel

MSB
CkSum

LSB
CkSum
MSB

Formulas

Index

Parameters
& Defaults
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Commanded Velocity (RAM Only)
Description:  Determines the commanded velocity based on the input step frequency.

Parameter Parameter Description Default Value

CmdVel Commanded Velocity N/A

Parameter Formula

CmdVel

VelocityRPS

CmdVel
0.0064

----------------------- 
 

25600
-----------------------------=

Index Parameter Description

104 CmdVel

Transmission Frame
Unit Address 104 CmdVel

LSB
CmdVel

MSB
CkSum

LSB
CkSum

MSB

Formulas

Index

Parameters
& Defaults
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Stored Drive Faults (Reserved EEPROM Parameter)
Description:  Determines the last 8 drive faults.

Commanded Position Counter (RAM Only)
Description:  Determines the accumulated commanded position in motor steps.

Parameter Parameter Description Default Value

StoredFlt1 Store Faults #1 - #4 (Newest Fault in LS Nibble) N/A

StoredFlt2 Store Faults #5 - #8 (Oldest Fault in MS Nibble) N/A

Index Parameter Description

105 StoredFlt1; StoredFlt2

Transmission Frame
Unit Address 105 StoredFlt1

LSB
StoredFlt1

MSB
StoredFlt2

LSB
StoredFlt2

MSB
CkSum

LSB
CkSum
MSB

Formulas - N/A

Index

Parameters
& Defaults

Parameter Parameter Description Default Value

StepCnt_h Commanded Motor Steps Upper Word 0 (0h)

StepCnt_l Commanded Motor Steps Lower Word 0 (0h)

Index Parameter Description

113 StepCnt_h; StepCnt_l

Transmission Frame
Unit Address 113 StepCnt_l

LSB
StepCnt_l

MSB
StepCnt_h

LSB
StepCnt_h

MSB
CkSum

LSB
CkSum

MSB

Formulas - N/A

Index

Parameters
& Defaults
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EEPROM Enable Switch
Description:  Determines if parameter writes are updated to the EEPROM or are only altered in 
RAM.  If EEPROM is disabled, all parameter changes are lost on power cycle or system reset.

Parameter Parameter Description Default Value

EE_Enable EEPROM Enable Value 1 (1h)

Index Parameter Description

115 EE_Enable

Transmission Frame
Unit Address 115 EE_Enable

LSB
EE_Enable

MSB
CkSum

LSB
CkSum
MSB

Formulas

Index

Parameters

& Defaults

Parameter Formula

EE_Enable EE_Enable = 0 EEPROM Disabled (Parameter changes are written to RAM only)

EE_Enable = 1 EEPROM Enabled (Parameter changes are written to EEPROM)
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System Status (RAM Only)
Description:  Determines the operational status of the drive.

Parameter Parameter Description Default Value

SysStatus System Operational Status 0 (0000h)

Index Parameter Description

116 SysStatus

Transmission Frame
Unit Address 116 SysStatus

LSB
SysStatus

MSB
CkSum

LSB
CkSum

MSB

Formulas

Index

Parameters
& Defaults

Bits 3 - 0
Status Value Drive Status

Bit 0 Input #1 Status
Bit 1 Input #2 Status
Bit 2 Input #3 Status
Bit 3 Input #4 Status

Bits 7 - 4
Bit 4 Output #1 Status
Bit 5 Motion Node Option
Bit 6 Shutdown Status
Bit 7 [Reserved]

Bits 8 - 11
Bit 8 - Bit 11 [Reserved]

Bits 12 - 15
0h No Faults
1h Stall Detection Fault
2h Undervoltage Fault
3h Overvoltage Fault
4h Overcurrent Fault
5h Interlock Fault
6h Overtemperature Fault
7h EEPROM Checksum Fault
8h Motor Characteristic Fault

9h - Fh [Reserved]
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Unit Address
Description:  Sets the unit address for RS232 / RS485 communications.

Parameter Parameter Description Default Value

UnitAddr Unit Address Number 1 (1h)

Map Index Parameter Description

118 UnitAddr

Transmission Frame
Unit Address 118 UnitAddr

LSB
UnitAddr

MSB
CkSum

LSB
CkSum
MSB

Formulas

Index

Parameters
& Defaults

Parameter Formula

UnitAddr Value from 1 to 255
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Software Shutdown (RAM Only)
Description:  Software override of the shutdown input.

Parameter Parameter Description Default Value

ShutDwn Shutdown Override 0 (0h)

Index Parameter Description

119 ShutDwn

Transmission Frame
Unit Address 119 ShutDwn

LSB
ShutDwn

MSB
CkSum

LSB
CkSum

MSB

Formulas

Index

Parameters
& Defaults

Parameter Formula

ShutDwn ShutDwn = 0 GUI Shutdown Override Disabled (Shutdown input in control)

EE_Enable = 1 GUI Shutdown Override Enabled (Drive is disabled 
regardless of shutdown input state)
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Appendix C - Using Non-IDC Motors with the Impulse

The Impulse drive is an advanced microstepper that employs special digital control techniques to 
effect Open Loop Stall Detect™, Multi-Stepping™, Dynamic Smoothing™, Extreme Smoothing™, 
and anti resonance control. Although these features can be applied to virtually any step motor, there 
are a number of parameters which must be determined for a given motor design in order to get these 
processes to work properly. These parameters include such elements as optimum current vector 
amplitude, saturation current, rotor inertia, and various electrical model parameters which are 
determined by proprietary means. 

IDC-supplied motors have been analyzed and modeled for use with the Impulse drive. If you select 
a non-IDC motor, there will likely be some degree of difficulty with Open Loop Stall Detect™, and 
anti-resonance control. The optimum parameters cannot generally be determined in the field. 
Contact your distributor for factory assistance in characterizing non-IDC motors. The remaining 
option for those using non-IDC motors is to use the Impulse as a standard drive by disabling the stall 
detection and anti resonance features.

ID’s S-Series motors have custom windings to provide optimum dynamic performance with the 
Impulse. If you use another manufacturer’s motor, it should meet the following guidelines:

1. 2 phase, hybrid, permanent magnet step motor.

2. 4, 6, or 8 lead motor.

3. Series or parallel inductance rating between 2 - 80 mH. Higher inductance motors will not 
damage the drive, but they will have limited dynamic performance.

4. A minimum high-pot test rating of 500 VDC.

If possible, use the manufacturer’s 160 VDC, bipolar current rating. With 4-lead motors, the 
manufacturer’s (bipolar) current rating translates directly to the Impulse current setting. 

Bifilar wound, 8-lead motors afford the opportunity to connect phase windings in series or parallel. 
The parallel connection uses twice the current required by the series connection. There is no industry 
standard color code for stepper phase leads (consult motor manufacturer). There are several pitfalls 
that users should be aware of: (1) Do not configure the drive to supply the parallel current level into 
a series-wired motor (this will damage motor windings). (2) The small dots in the motor wiring 
diagrams indicate phasing. Windings must be connected in series-aiding or parallel-aiding 
configurations as shown below. If a phase is connected in opposition, the circuit will have no net 
inductance and will cause an overcurrent fault in the drive. The same relationship applies to 
resistance. (3) Mixing connections (e.g. A to B) will cause an overcurrent fault in the drive.

6-lead motors may be used with the Impulse drive by leaving center-taps unconnected and using the 
two outside conductors of each phase. Do not connect the center-tap of a 6-lead motor to the Impulse. 
This will result in an overcurrent fault.

Motor 
Wiring

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix C - Using Non-IDC Motors with the Impulse

C-2

Custom or User-Defined Motors

This section applies to users of non-IDC motors or those who would like to modify an existing motor 
file.

Note: All motor characteristics must be entered in the text input boxes before the Advanced tuning 
feature will be available.

• Click on the Add Custom Motor button and the Motor Editor will appear.

• Enter a file name for your custom motor in the Motor File Name text-entry box. File 
names may be up to eight (8) characters in length (all keyboard characters are valid). This 
also applies if you are editing an existing IDC motor file.

• Enter the Mechanical characteristics of your custom motor. 
Rotor Inertia in kg-m2 
Tooth Count in number of teeth on the rotor

• Enter the Electrical characteristics of your custom motor.
Operating Current is the current-magnitude command to the drive in Amps (it is not 
RMS). The value entered represents the peak amplitude of the phase currents.

Saturation Current (in Amps) is critical for the implementation of the Impulse’s exclusive 
Open Loop Stall DetectTM feature. Saturation Current has been pre-configured under labo-
ratory conditions for IDC motors, but cannot be accurately determined in the field for cus-
tom motors. If an incorrect Saturation Current is entered, the Open Loop Stall Detect 
(OLSD) feature may be  ineffective. Contact your distributor or IDC Applications Engi-
neering for assistance.

In the absence of an accurate Saturation Current, you have three options: 1) enter an esti-
mated value based on the characteristics of a similar type of motor,  2) enter the same value 
as the Operating Current, or 3) disable the OLSD feature (see Application Developer Setup 
> Axis > Advanced tab to disable Stall Detection).

Rated Torque is the rated torque (N-m) of the manufacturer’s motor at the rated current. 
This may be set to zero (0) if unknown and it will have no effect on the drive. This number 
is used by the Speed Torque Curve utility and is numerically equal to the quotient of the 
manufacturer’s specified 2-phase resting torque divided by the specified current (Nm/
Amp). Always convert torque to Newton-meters.

Rated Current is the amplitude of the current generated when the windings are shorted and 
the motor’s rotor is back-driven (forced to move). This short-circuit current is of constant 
amplitude for speeds above 2 RPS. Determining Rated Current in the field is very diffi-
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cult, requiring special test equipment and fixtures. Contact your distributor or IDC Applica-
tions Engineering for assistance.

Press Save if you intend to use the Advanced Tuning feature building a custom motor file. 
Press OK if you want to save the file and return to the Project Wizard.

Note: A user-defined motor file may be deleted by selecting the file and pressing the Delete 
button. IDC motor files cannot be deleted.

5. Advanced Tuning

Motor Editor - Advanced is used only for building a custom motor file. All motor file 
parameters are editable using text input boxes. Note: This feature is typically used to build 
motor files for non-IDC motors. Only motors with characteristics matching those of IDC 
motors will benefit from the advanced features of the Impulse drive (i.e. X-Smoothness™, 
Dynamic Smoothing™).  

• Click the Advanced button and the Advanced tuning window will appear as shown.  

Test Speeds 1, 2, 3

• Enter the recommended values. These values will be used by the X-Smoothness feature of 
the Axis Setup menu.

X-Smoothness L1 and L2

• Depending on the Mechanical and Electrical parameters entered previously in the Motor 
Editor, there may or may not be X-Smoothness values in these text input boxes. Existing 
values may be changed or left as is. These values will be used in the X-Smoothness feature 
of the Axis Setup menu.

Dynamic Smoothing

Note: If Gain is reduced by a factor (K), Feed Forward should be reduced by factor (K2).

• Gain - Enter the recommended value. Note: the default value is 2621. Generally, the 
smaller the value, the more aggressive the smoothing action. The maximum gain is 20.

• Feed Forward - Enter the recommended value or leave blank. Note: default value is 3641.
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Anti -Resonance

• Damping Gain 1 - Enter the recommended value.

• Damping Gain 2 - If a value is present you may leave it as 
is or enter a value according to the table:

Note: Both Damping Gains (1 and 2) must be configured.

• Click OK and you will return to the Motor Editor.

• Click OK or Save in the Motor Editor window. You will be prompted to overwrite an exist-
ing file.

Damping Gain 2
Motor Frame Size Enter This Value

17 6.0
23 4.0
34 2.0
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